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Check Bug Reports for Issues and Fixes

Software is inherently complex and is not free of errors. The output of a code generator
might contain bugs, some of which are not detected by a compiler. MathWorks

reports critical known bugs brought to its attention on its Bug Report system at
www.mathworks.com/support/bugreports/. Use the Saved Searches and Watched Bugs
tool with the search phrase "Incorrect Code Generation" to obtain a report of known bugs
that produce code that might compile and execute, but still produce wrong answers.

The bug reports are an integral part of the documentation for each release. Examine
periodically all bug reports for a release, as such reports may identify inconsistencies
between the actual behavior of a release you are using and the behavior described in this
documentation.

In addition to reviewing bug reports, you should implement a verification and validation
strategy to identify potential bugs in your design, code, and tools.


http://www.mathworks.com/support/bugreports/
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Embedded Coder Product Description
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Generate C and C++ code optimized for embedded systems

Embedded Coder® generates readable, compact, and fast C and C++ code for use on
embedded processors, on-target rapid prototyping boards, and microprocessors used in

mass production. Embedded Coder enables additional MATLAB® Coder™ and Simulink®
Coder configuration options and advanced optimizations for fine-grain control of the
generated code’s functions, files, and data. These optimizations improve code efficiency
and facilitate integration with legacy code, data types, and calibration parameters used
in production. You can incorporate a third-party development environment into the build
process to produce an executable for turnkey deployment on your embedded system.

Embedded Coder offers built-in support for AUTOSAR and ASAP2 software standards. It
also provides traceability reports, code interface documentation, and automated software
verification. Support for industry standards is available through IEC Certification Kit
(for ISO 26262 and IEC 61508) and DO Qualification Kit (for DO-178).

Learn more about MathWorks support for certification in automotive, aerospace, and
industrial automation.

Key Features

*  Optimization and code configuration options that extend MATLAB Coder and
Simulink Coder

+ Storage class, type, and alias definition using Simulink data dictionary capabilities

*  Processor-specific code optimization

*  Multirate, multitask, and multicore code execution with or without an RTOS

* Code verification, including SIL and PIL testing, custom comments, and code reports
with tracing of models to and from code and requirements

Integration with Texas Instruments™ Code Composer Studio™, Analog Devices®
VisualDSP++%, and other third-party embedded development environments

+ Standards support, including ASAP2, AUTOSAR, DO-178, IEC 61508, ISO 26262,
and MISRA-C


http://www.mathworks.com/products/iec-61508/
http://www.mathworks.com/products/do-178/
http://www.mathworks.com/automotive/standards/iso-26262.html
http://www.mathworks.com/aerospace-defense/standards/do-178b.html
http://www.mathworks.com/industrial-automation-machinery/standards/iec-61508.html

Code Generation Technology

Code Generation Technology

MathWorks® code generation technology generates C or C++ code and executables for
algorithms. You can write algorithms programmatically with MATLAB or graphically in
the Simulink environment. You can generate code for MATLAB functions and Simulink
blocks that are useful for real-time or embedded applications. The generated source code
and executables for floating-point algorithms match the functional behavior of MATLAB
code execution and Simulink simulations to a high degree of fidelity. Using the Fixed-
Point Designer product, you can generate fixed-point code that provides a bit-wise match
to model simulation results. Such broad support and high degree of accuracy are possible
because code generation is tightly integrated with the MATLAB and Simulink execution
and simulation engines. The built-in accelerated simulation modes in Simulink use code
generation technology.

Code generation technology and related products provide tooling that you can apply
to the V-model for system development. The V-model is a representation of system
development that highlights verification and validation steps in the development process.

For more information, see “Validation and Verification for System Development” on page
1-8.

To learn model design patterns that include Simulink blocks, Stateflow® charts, and
MATLAB functions, and map to commonly used C constructs, see “Modeling Patterns for
C Code” in the Embedded Coder documentation.

1-3


http://www.mathworks.com/products/simfixed/
http://www.mathworks.com/products/simfixed/
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Code Generation Workflows with Embedded Coder
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The Embedded Coder product extends the MATLAB Coder and Simulink Coder products
with key features that you can use for embedded software development. Using the
Embedded Coder product, you can generate code that has the clarity and efficiency of
professional handwritten code. For example, you can:

*  Generate code that is compact and fast, which is essential for real-time simulators,
on-target rapid prototyping boards, microprocessors used in mass production, and
embedded systems.

+ Customize the appearance of the generated code.

*  Optimize generated code for a specific target environment.

+ Integrate existing applications, functions, and data.

+ Enable tracing, reporting, and testing options that facilitate code verification

activities.

Embedded Coder supports two workflows for designing, implementing, and verifying
generated C or C++ code. The following figure shows the design and deployment
environment options.



Code Generation Workflows with Embedded Coder

Code Generation from Code Generation from
MATLAB Code Simulink Models
MATLAB Sirmulink
MATLAB Code MATLAB Blocks for
for Code Function Code
Generation Block Generation
MATLAE Coder Simulink Coder
and and
Embedded Coder Embedded Coder

l

CorC+
Code

|

Compiler or
IDE toolchain

|

Exzcutable program
(in target environment)

Although not shown in this figure, other products that support code generation, such as
Stateflow software, are available.

To develop algorithms with MATLAB code for code generation, see “Code Generation
from MATLAB Code” on page 1-5.

To implement algorithms as Simulink blocks and Stateflow charts in a Simulink model,

and generate C or C++ code, see “Code Generation from Simulink Models” on page
1-6.

Code Generation from MATLAB Code

The code generation from MATLAB code workflow with Embedded Coder requires the
following products:

1-5
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- MATLAB
+ MATLAB Coder
+ Embedded Coder

MATLAB Coder supports a subset of core MATLAB language features, including
program control constructs, functions, and matrix operations. To generate C or C+

+ code, you can use MATLAB Coder projects or enter the function codegen in the
MATLAB Command Window. Embedded Coder provides additional options and advanced
optimizations for fine-grain control of the generated code’s functions, files, and data.

For more information about these options and optimizations , see “Embedded Coder
Capabilities for Code Generation from MATLAB Code” on page 2-3.

For more information about generating code from MATLAB code, see “MATLAB Code for
Code Generation Workflow Overview” in the MATLAB Coder documentation.

To get started generating code from MATLAB code using Embedded Coder, see
“Generate C Code from MATLAB Code” on page 2-2.

Code Generation from Simulink Models

The code generation from Simulink models workflow with Embedded Coder requires the
following products:

+ MATLAB

+ MATLAB Coder
*  Simulink

*  Simulink Coder
* Embedded Coder

You can implement algorithms as Simulink blocks and Stateflow charts in a Simulink
model. To generate C or C++ code from a Simulink model, Embedded Coder provides
additional features for implementing, configuring, and verifying your model for code
generation.

If you have algorithms written in MATLAB code, you can include the MATLAB code in a

Simulink model or subsystem by using the MATLAB Function block. When you generate
C or C++ code for a Simulink model, the MATLAB code in the MATLAB Function block is
also generated into C or C++ code and included in the generated source code.



Code Generation Workflows with Embedded Coder

To get started generating code from Simulink models using Embedded Coder, see
“Generate C Code from Simulink Models” on page 3-2.

To learn how to model and generate code for commonly used C constructs using Simulink
blocks, Stateflow charts, and MATLAB functions, see “Modeling Patterns for C Code”.

1-7
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Validation and Verification for System Development
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An approach to validating and verifying system development is the V-model.

In this section...

“V-Model for System Development” on page 1-8
“Types of Simulation and Prototyping in the V-Model” on page 1-10
“Types of In-the-Loop Testing in the V-Model” on page 1-11

“Mapping of Code Generation Goals to the V-Model” on page 1-12

V-Model for System Development

The V-model is a representation of system development that highlights verification and
validation steps in the system development process. As the following figure shows, the
left side of the V' identifies steps that lead to code generation, including requirements
analysis, system specification, detailed software design, and coding. The right side of
the V focuses on the verification and validation of steps cited on the left side, including
software integration and system integration.



Validation and Verification for System Development

Verification and validation

. . e —
Simulation

Hardware-in-the-loop

Rapid simulation (HIL) testing

o System Integration
f o
System Specification and Calibration

System simulation (export)

Rapid prototyping

Processor-in-the-loop
(PIL) testing

Software _Detalled Software Integration
Design

On-target rapid prototyping Software-in-the-loop

(SIL) testing

Production code generation
Model encryption (export)

Depending on your application and its role in the process, you might focus on one or more
of the steps called out in the V-model or repeat steps at several stages of the V-model.
Code generation technology and related products provide tooling that you can apply to
the V-model for system development. For more information about how you can apply

MathWorks code generation technology and related products provide tooling to the V-
model process, see:

“Types of Simulation and Prototyping in the V-Model” on page 1-10
“Types of In-the-Loop Testing in the V-Model” on page 1-11

“Mapping of Code Generation Goals to the V-Model” on page 1-12

1-9
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Types of Simulation and Prototyping in the V-Model

The following table compares the types of simulation and prototyping identified on the
left side of the V-model diagram.

Host-Based Standalone Rapid Rapid Prototyping |On-Target Rapid
Simulation Simulations Prototyping
Purpose Test and validate |Refine, test, Test new ideas Refine and calibrate
functionality of and validate and research designs during
concept model functionality of development process
concept model in
nonreal time
Execution Host computer Host computer PC or nontarget Embedded
hardware hardware computing unit
Standalone (ECU) or near-
executable runs production hardware
outside of MATLAB
and Simulink
environments
Code Not applicable Not applicable Less emphasis on |More emphasis on
efficiency code efficiency and |code efficiency and I/
and I/O I/0 latency O latency
latency

Ease of use
and cost

1-10

Can simulate
component
(algorithm or
controller) and
environment (or
plant)

Normal mode
simulation in
Simulink enables
you to access,
display, and
tune data during
verification

Easy to simulate
models of hybrid
dynamic systems
that include
components and
environment models

Ideal for batch
or Monte Carlo
simulations

Can repeat
simulations with
varying data sets,
interactively or
programmatically

Might require
custom real-time
simulators and
hardware

Might be done
with inexpensive
off-the-shelf PC
hardware and I/0
cards

Might use existing
hardware, thus less
expensive and more
convenient




Validation and Verification for System Development

Host-Based Standalone Rapid Rapid Prototyping |On-Target Rapid
Simulation Simulations Prototyping
Can accelerate with scripts, without

Simulink rebuilding the model

simulations with
Accelerated and
Rapid Accelerated
modes

Can connect to
Simulink to monitor
signals and tune
parameters

Types of In-the-Loop Testing in the V-Model

The following table compares the types of in-the-loop testing for verification and
validation identified on the right side of the V-model diagram.

SIL Testing

PIL Testing on
Embedded Hardware

PIL Testing on
Instruction Set
Simulator

HIL Testing

Purpose

Verify component
source code

Verify component
object code

Verify component
object code

Verify system
functionality

Fidelity and

Two options:

Same object code

Same object code

Same executable

accuracy code
Same source Bit accurate for Bit accurate for
code as target, fixed-point math fixed-point math |Bit accurate for
but might have fixed-point math
numerical Cycle accurate Might not be cycle
differences because code runs on|accurate Cycle accurate
hardware
Changes source Use real and
code to emulate emulated system I/O
word sizes, but 1s
bit accurate for
fixed-point math
Execution Host Target Host Target
platforms
Ease of use |Desktop Executes on desk or |[Desktop Executes on test
and cost convenience test bench convenience bench or in lab

1-11
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SIL Testing

PIL Testing on
Embedded Hardware

PIL Testing on
Instruction Set
Simulator

HIL Testing

Executes only in
Simulink

Reduced hardware
cost

Uses hardware —
process board and
cables

Executes only on
host computer
with Simulink
and integrated
development
environment (IDE)

Reduced hardware
cost

Uses hardware —
processor, embedded
computer unit
(ECU), I/0 devices,
and cables

Real-time
capability

Not real time

Not real time
(between samples)

Not real time
(between samples)

Hard real time

Mapping of Code Generation Goals to the V-Model

The following tables list goals that you might have, as you apply code generation
technology, and where to find guidance on how to meet those goals. Each table focuses on
goals that pertain to a step of the V-model for system development.

Documenting and Validating Requirements

Developing a Model Executable Specification

Developing a Detailed Software Design

Generating the Application Code

Integrating and Verifying Software

Integrating, Verifying, and Calibrating System Components

Documenting and Validating Requirements

Goals

Related Product Information

Examples

Capture requirements in

a document, spreadsheet,
data base, or requirements
management tool

“Simulink Report Generator”

Third-party vendor tools such as
Microsoft® Word, Microsoft Excel®,
raw HTML, or IBM® Rational®
DOORS"

1-12
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Goals

Related Product Information

Examples

Associate requirements
documents with objects in
concept models

Generate a report on
requirements associated with a
model

“Requirements Traceability”
— Simulink Verification and
Validation™

Bidirectional tracing in Microsoft
Word, Microsoft Excel, HTML, and
IBM Rational DOORS

slvnvdemo_fuelsys do

creq

Include requirements links in
generated code

“Review of Requirements Links”
— Simulink Verification and
Validation

rtwdemo_requirements

Trace model blocks and
subsystems to generated code
and vice versa

“Code Tracing” — Embedded
Coder

rtwdemo_hyperlinks

Verify, refine, and test concept
model in non real time on a
host system

“Model Architecture and Design”
— Simulink Coder

“Model Architecture and Design”
— Embedded Coder

“Simulation” — Simulink

“Acceleration” — Simulink

“Air-Fuel Ratio Control
System with Stateflow
Charts”

Run standalone rapid
simulations

Run batch or Monte-Carlo
simulations

Repeat simulations with
varying data sets, interactively
or programmatically with
scripts, without rebuilding the
model

Tune parameters and monitor
signals interactively

“Accelerate, Refine, and Test
Hybrid Dynamic System on Host
Computer by Using RSim Target”

“Set Up and Use Host/Target
Communication Channel”

“Run Rapid Simulations Over
Range of Parameter Values”

“Run Batch Simulations
Without Recompiling
Generated Code”

“Use MAT-Files to Feed D
to Inport Blocks for Rapid
Simulations”

ata

1-13
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Goals

Related Product Information

Examples

Simulate models for hybrid
dynamic systems that
include components and an
environment or plant that
requires variable-step solvers
and zero-crossing detection

Distribute simulation runs
across multiple computers

“Simulink Test”

“MATLAB Distributed Computing
Server”

“Parallel Computing Toolbox”

1-14
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Developing a Model Executable Specification

Goals

Related Product Information

Examples

Produce design artifacts for
algorithms that you develop in
MATLAB code for reviews and

archiving

“MATLAB Report Generator”

Produce design artifacts from
Simulink and Stateflow models
for reviews and archiving

“System Design Description” —
Simulink Report Generator™

rtwdemo_codegenrpt

Add one or more components
to another environment for
system simulation

Refine a component model

Refine an integrated system
model

Verify functionality of a model
in nonreal time

Test a concept model

“Deploy Algorithm Model for
Real-Time Rapid Prototyping”

Schedule generated code

“Absolute and Elapsed Time
Computation”

“Time-Based Scheduling and
Code Generation”

“Asynchronous Events”

rtwdemos, select Multirate
Support

Specify function boundaries of
systems

“Subsystems”

rtwdemo_atomic
rtwdemo_ssreuse
rtwdemo_filepart
rtwdemo_exporting_function

Specify components and
boundaries for design and
incremental code generation

“Component-Based Modeling”
— Simulink Coder

“Component-Based Modeling”
— Embedded Coder

rtwdemo_mdlreftop

1-15
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Goals

Related Product Information

Examples

Specify function interfaces

so that external software can
compile, build, and invoke the
generated code

“Function and Class Interfaces”
— Simulink Coder

“Function and Class Interfaces”
— Embedded Coder

rtwdemo_fcnprotoctrl
rtwdemo_cppclass

Manage data packaging in
generated code for integrating
and packaging data

“File Packaging” — Simulink
Coder

“File Packaging” — Embedded
Coder

rtwdemos, select Function,
File and Data Packaging

Generate and control the
format of comments and
identifiers in generated code

“Add Custom Comments to
Generated Code” — Embedded
Coder

“Customize Generated
Identifier Naming Rules” —
Embedded Coder

rtwdemo_comments
rtwdemo_symbols

Create a zip file that contains
generated code files, static
files, and dependent data to
build generated code in an
environment other than your
host computer

“Relocate Code to Another
Development Environment”—
Simulink Coder

rtwdemo_buildinfo

Export models for validation
in a system simulator using
shared libraries

“Package Generated Code as
Shared Object Libraries” —
Embedded Coder

rtwdemo_shrlib

Refine component and
environment model designs
by rapidly iterating between
algorithm design and
prototyping

Verify whether a component
can adequately control a
physical system in non-real
time

1-16

“Deployment” — Simulink
Coder

“Deployment” — Embedded
Coder

rtwdemo_profile




Validation and Verification for System Development

Goals

Related Product Information

Examples

Evaluate system performance
before laying out hardware,
coding production software, or
committing to a fixed design

Test hardware

Generate code for rapid
prototyping

“Function and Class Interfaces”

“Entry-Point Functions and
Scheduling”

“Generate Modular Function
Code” —Embedded Coder

rtwdemo_counter
rtwdemo_async

Generate code for rapid
prototyping in hard real time,
using PCs

“Simulink Real-Time”

i

“Simulink Real-Time Examples’

Generate code for rapid
prototyping in soft real time,
using PCs

“Simulink Desktop Real-Time”

sldrtex_vdp (and others)

Developing a Detailed Software Design

Goals

Related Product Information

Examples

Refine a model design for
representation and storage of
data in generated code

“Data Representation” —
Simulink Coder

“Data Representation” —
Embedded Coder

Select code generation features
for deployment

“Target Environment
Configuration” — Simulink
Coder

“Target Environment
Configuration” — Embedded
Coder

“Sharing Utility Code” —
Embedded Coder

rtwdemo_counter
rtwdemo_async

“Sample Workflows” in the
Embedded Coder documentation

1-17
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Goals

Related Product Information

Examples

“AUTOSAR Code Generation”
— Embedded Coder

Specify target hardware
settings

“Target Environment
Configuration” — Simulink
Coder

“Target Environment
Configuration”— Embedded
Coder

rtwdemo_targetsettings

Design model variants

“Define, Configure, and
Activate Variants” — Simulink

“Variant Systems” —
Embedded Coder

Specify fixed-point algorithms
in Simulink, Stateflow, and the
MATLAB language subset for
code generation

“Data Types and Scaling” —
Fixed-Point Designer

“Fixed-Point Code Generation”
— Fixed-Point Designer

rtwdemo_fixptl
“Air-Fuel Ratio Control System
with Fixed-Point Data”

Convert a floating-point model
or subsystem to a fixed-point
representation

“Conversion Using Simulation
Data” — Fixed-Point Designer

“Conversion Using Range
Analysis” — Fixed-Point
Designer

fxpdemo_fpa

Iterate to obtain an optimal
fixed-point design, using
autoscaling

“Data Types and Scaling” —
Fixed-Point Designer

fxpdemo_feedback

Create or rename data types
specifically for your application

“What Are User-Defined Data
Types?” — Embedded Coder

“Data Type Replacement” —
Embedded Coder

rtwdemo_udt

Control the format of identifiers
in generated code

“Customize Generated
Identifier Naming Rules” —
Embedded Coder

rtwdemo_symbols

1-18
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Goals

Related Product Information

Examples

Specify how signals, tunable
parameters, block states, and
data objects are declared,
stored, and represented in
generated code

“Custom Storage Classes” —
Embedded Coder

rtwdemo_cscpredef

Create a data dictionary for a
model

“Data Definition and
Declaration Management” —
Embedded Coder

rtwdemo_advsc

Relocate data segments for
generated functions and data
using #pragmas for calibration
or data access

“Control Data and Function
Placement in Memory by
Inserting Pragmas” —
Embedded Coder

rtwdemo_memsec

Assess and adjust model
configuration parameters based
on the application and an
expected run-time environment

“Configuration” — Simulink
Coder

“Configuration” — Embedded
Coder

“Generate Code Using
Simulink® Coder™”
“Generate Code Using
Embedded Coder®”

Check a model against basic
modeling guidelines

“Run Model Checks” —
Simulink

rtwdemo_advisorl

Add custom checks to the

“Customization and

slvnvdemo_mdladv

Simulink Model Advisor Automation”
Check a model against custom |“Run Model Checks” —
standards or guidelines Simulink

Check a model against industry
standards and guidelines
(MathWorks Automotive
Advisory Board (MAAB), IEC
61508, IEC 62304, ISO 26262,
EN 50128 and DO-178)

“Standards, Guidelines, and
Block Usage” — Embedded
Coder

“Model Guidelines Compliance”
— Simulink Verification and
Validation

rtwdemo_iec61508

Obtain model coverage for
structural coverage analysis
such as MC/DC

“Model Coverage Analysis” —
Simulink Design Verifier™

Prove properties and generate
test vectors for models

Simulink Design Verifier

sldvdemo_cruise_control
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Goals

Related Product Information

Examples

sldvdemo_cruise_control -
verification

Generate reports of models and
software designs

“MATLAB Report Generator”
— MATLAB Report Generator

“Simulink Report Generator” —
Simulink Report Generator

“System Design Description” —
Simulink Report Generator

rtwdemo_codegenrpt

Conduct reviews of your model
and software designs with
coworkers, customers, and
suppliers who do not have
Simulink available

“Model Web Views” —
Simulink Report Generator

“Model Comparison” —
Simulink Report Generator

sixml_sfcar

Refine the concept model of
your component or system

Test and validate the model
functionality in real time

Test the hardware

Obtain real-time profiles and
code metrics for analysis and
sizing based on your embedded
processor

Assess the feasibility of the
algorithm based on integration
with the environment or plant
hardware

“Deployment” — Simulink
Coder

“Deployment” — Embedded
Coder

“Code Execution Profiling” —
Embedded Coder

“Static Code Metrics” —
Embedded Coder

rtwdemos, select Embedded
IDEs or Embedded Targets

Generate source code for your
models, integrate the code
into your production build
environment, and run it on
existing hardware

“Code Generation” — Simulink
Coder

“Code Generation” —
Embedded Coder

rtwdemo_counter
rtwdemo_fcnprotoctrl
rtwdemo_cppclass
rtwdemo_async

“Sample Workflows” in the
Embedded Coder documentation
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Goals

Related Product Information

Examples

Integrate existing externally
written C or C++ code with
your model for simulation and
code generation

“Block Creation” — Simulink

“External Code Integration” —
Simulink Coder

“External Code Integration” —
Embedded Coder

rtwdemos, select Integrating
with C Code or Integrating
with C++ Code

Generate code for on-target
rapid prototyping on specific
embedded microprocessors and
IDEs

“Deploy Generated Embedded
System Software to Application
Target Platforms” — Embedded
Coder

In rtwdemos, select one of the
following: Embedded IDEs or
Embedded Targets

Generating the Application Code

Goals

Related Product Information

Examples

Optimize generated ANSI®

C code for production (for
example, disable floating-
point code, remove termination
and error handling code, and
combine code entry points into
single functions)

“Performance” — Simulink

Coder

“Performance” — Embedded
Coder

rtwdemos, select
Optimizations

Optimize code for a specific
run-time environment, using
specialized function libraries

“Code Replacement”™—
Simulink Coder

“Code Replacement” —
Embedded Coder

“Code Replacement
Customization” — Embedded
Coder

“Optimize Generated Code
By Developing and Using
Code Replacement Libraries -
Simulink®”

Control the format and style of
generated code

“Control Code Style” —
Embedded Coder

rtwdemo_parentheses

Control comments inserted into
generated code

“Add Custom Comments to
Generated Code” — Embedded
Coder

rtwdemo_comments
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Goals

Related Product Information

Examples

Enter special instructions
or tags for postprocessing by

“Customize Post-Code-
Generation Build Processing”

rtwdemo_buildinfo

third-party tools or processes |— Simulink Coder
Include requirements links in  |“Review of Requirements rtwdemo_requirements
generated code Links” — Simulink Verification

and Validation

Trace model blocks and
subsystems to generated code
and vice versa

“Code Tracing” — Embedded
Coder

“Standards, Guidelines, and
Block Usage” — Embedded
Coder

rtwdemo_comments
rtwdemo_hyperlinks

Integrate existing externally
written code with code
generated for a model

“Block Creation” — Simulink

“External Code Integration” —
Simulink Coder

“External Code Integration” —

rtwdemos, select Integrating
with C Code or Integrating
with C++ Code

Embedded Coder
Verify generated code for “MISRA C Guidelines” —
MISRA C** and other run-time |Embedded Coder

violations

“Polyspace Bug Finder”

“Polyspace Code Prover”

Protect the intellectual
property of component model
design and generated code

Generate a binary file (shared
library)

“Protected Model” — Simulink

“Package Generated Code as
Shared Object Libraries” —
Embedded Coder

Generate a MEX-file S-function
for a model or subsystem so
that it can be shared with a
third-party vendor

“Automate S-Function
Generation with S-Function
Builder” — Simulink Coder
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Goals

Related Product Information

Examples

Generate a shared library for
a model or subsystem so that
it can be shared with a third-
party vendor

“Package Generated Code as
Shared Object Libraries” —
Embedded Coder

Test generated production code
with an environment or plant
model to verify a conversion of
the model to code

“Software-in-the-Loop (SIL)
Simulation” — Embedded
Coder

“Test Generated Code Using
Software-in-the-Loop (SIL) and
Processor-in-the-Loop (PIL)
Simulation”

Create an S-function wrapper
for calling your generated
source code from a model
running in Simulink

“Write Wrapper S-Function and
TLC Files” — Simulink Coder

Set up and run SIL tests on
your host computer

“Software-in-the-Loop (SIL)
Simulation” — Embedded
Coder

“Test Generated Code Using
Software-in-the-Loop (SIL) and
Processor-in-the-Loop (PIL)
Simulation”

a. MISRA® and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the MISRA Consortium.

Integrating and Verifying Software

Goals

Related Product Information

Examples

Integrate existing externally
written C or C++ code with a
model for simulation and code
generation

“Block Creation” — Simulink

“External Code Integration” —
Simulink Coder

“External Code Integration” —
Embedded Coder

rtwdemos, select Integrating
with C Code or Integrating
with C++ Code

Connect to data interfaces
for generated C code data
structures

“Data Exchange Interfaces” —
Simulink Coder

“Data Exchange Interfaces” —

rtwdemo_capi
rtwdemo_asap?2

Embedded Coder
Control the generation of code |“Function and Class Interfaces” | rtwdemo_fcnprotoctrl
interfaces so that external — Embedded Coder rtwdemo_cppclass
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Goals

Related Product Information

Examples

software can compile, build,
and invoke the generated code

Export virtual and function-call
subsystems

“Export Function-Call
Subsystems” — Embedded
Coder

rtwdemo_exporting_function

Include target-specific code

“Code Replacement” —
Simulink Coder

“Code Replacement” —
Embedded Coder

“Code Replacement
Customization” — Embedded
Coder

“Optimize Generated Code
By Developing and Using
Code Replacement Libraries -
Simulink®”

Customize and control the build
process

“Build Process Customization”
— Simulink Coder

rtwdemo_buildinfo

Create a zip file that contains
generated code files, static
files, and dependent data to
build the generated code in an
environment other than your
host computer

“Relocate Code to Another
Development Environment” —
Simulink Coder

rtwdemo_buildinfo

Integrate software components
as a complete system for testing
in the target environment

“Target Environment
Verification” — Embedded
Coder

Generate source code for
integration with specific
production environments

“Code Generation” — Simulink
Coder

“Code Generation” —
Embedded Coder

rtwdemo_async
“Sample Workflows” in the
Embedded Coder documentation

Integrate code for a specific
run-time environment, using
specialized function libraries
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Goals

Related Product Information

Examples

“Code Replacement
Customization” — Embedded
Coder

Enter special instructions
or tags for postprocessing by
third-party tools or processes

“Customize Post-Code-
Generation Build Processing”
— Simulink Coder

rtwdemo_buildinfo

Integrate existing externally
written code with code
generated for a model

“Block Creation” — Simulink

“External Code Integration” —
Simulink Coder

“External Code Integration” —
Embedded Coder

rtwdemos, select Integrating
with C Code or Integrating
with C++ Code

Connect to data interfaces
for the generated C code data
structures

“Data Exchange Interfaces” —
Simulink Coder

“Data Exchange Interfaces” —
Embedded Coder

rtwdemo_capi
rtwdemo_asap?2

Schedule the generated code

“Timers”
“Time-Based Scheduling”

“Event-Based Scheduling”

rtwdemos, select Multirate
Support

Verify object code files in a
target environment

“Software-in-the-Loop (SIL)
Simulation” — Embedded
Coder

“Test Generated Code Using
Software-in-the-Loop (SIL) and
Processor-in-the-Loop (PIL)
Simulation”

Set up and run PIL tests on
your target system

“Processor-in-the-Loop (PIL)
Simulation” — Embedded
Coder

“Test Generated Code Using
Software-in-the-Loop (SIL) and
Processor-in-the-Loop (PIL)
Simulation”

“Configure Processor-in-the-
Loop (PIL) for a Custom Target”

“Create a Target
Communication Channel for
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Goals

Related Product Information

Examples

Processor-in-the-Loop (PIL)
Simulation”

See the list of supported
hardware for the Embedded
Coder product on the
MathWorks Web site, and then
find an example for the related
product of interest

1-26



http://www.mathworks.com/hardware-support/index.html?q=%20product:%22Embedded+Coder%22
http://www.mathworks.com/hardware-support/index.html?q=%20product:%22Embedded+Coder%22

Validation and Verification for System Development

Integrating, Verifying, and Calibrating System Components

Goals Related Product Information Examples
Integrate the software and “Deploy Algorithm Model for
its microprocessor with the Real-Time Rapid Prototyping”

hardware environment for the

final embedded system product |‘Deploy Environment Model for
Real-Time Hardware-In-the-

Add the complexity of the Loop (HIL) Simulation”
environment (or plant) under
control to the test platform “Deploy Generated Standalone

Executables To Target
Test and verify the embedded |Hardware” — Embedded Coder
system or control unit by using

a real-time target environment | Deploy Generated Embedded
System Software to Application

Target Platforms” — Embedded

Coder
Generate source code for HIL “Code Generation” — Simulink
testing Coder

“Code Generation” —
Embedded Coder

“Deploy Environment Model for
Real-Time Hardware-In-the-
Loop (HIL) Simulation”

Conduct hard real-time HIL “Simulink Real-Time” “Simulink Real-Time Examples”
testing using PCs

Tune ECU properly for its “Data Exchange Interfaces” — |rtwdemo_capi

intended use Simulink Coder rtwdemo_asap2

“Data Exchange Interfaces” —
Embedded Coder

Generate ASAP2 data files “Export ASAP2 File for Data rtwdemo_asap?2
Measurement and Calibration”
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Goals Related Product Information Examples
Generate C API data interface |“Exchange Data Between rtwdemo_capi
files Generated and External Code

Using C APT”
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Target Environments and Applications

In this section...

“About Target Environments” on page 1-29

“Types of Target Environments” on page 1-29

“Applications of Supported Target Environments” on page 1-31

About Target Environments

In addition to generating source code, the code generator produces make or project

files to build an executable program for a specific target environment. The generated
make or project files are optional. If you prefer, you can build an executable for the
generated source files by using an existing target build environment, such as a third-
party integrated development environment (IDE). Applications of generated code range
from calling a few exported C or C++ functions on a host computer to generating a
complete executable program using a custom build process, for custom hardware, in

an environment completely separate from the host computer running MATLAB and
Simulink.

The code generator provides built-in system target files that generate, build, and execute
code for specific target environments. These system target files offer varying degrees

of support for interacting with the generated code to log data, tune parameters, and
experiment with or without Simulink as the external interface to your generated code.

Types of Target Environments

Before you select a system target file, identify the target environment on which you
expect to execute your generated code. The most common target environments include
environments listed in the following table.

Target Environment | Description

Host computer The same computer that runs MATLAB and Simulink. Typically, a host
computer is a PC or UNIX"® environment that uses a non-real-time operating
system, such as Microsoft Windows® or Linux®. Non-real-time (general
purpose) operating systems are nondeterministic. For example, those
operating systems might suspend code execution to run an operating system
service and then, after providing the service, continue code execution.
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Target Environment

Description

Therefore, the executable for your generated code might run faster or slower
than the sample rates that you specified in your model.

Real-time
simulator

A different computer than the host computer. A real-time simulator can be
a PC or UNIX environment that uses a real-time operating system (RTOS),
such as:

*  Simulink Real-Time system

+ A real-time Linux system

A Versa Module Eurocard (VME) chassis with PowerPC® processors

running a commercial RTOS, such as VxWorks® from Wind River®
Systems

The generated code runs in real time. The exact nature of execution varies
based on the particular behavior of the system hardware and RTOS.

Typically, a real-time simulator connects to a host computer for data logging,
interactive parameter tuning, and Monte Carlo batch execution studies.

Embedded
microprocessor

A computer that you eventually disconnect from a host computer and run as
a standalone computer as part of an electronics-based product. Embedded
microprocessors range in price and performance, from high-end digital signal
processors (DSPs) to process communication signals to inexpensive 8-bit
fixed-point microcontrollers in mass production (for example, electronic parts
produced in the millions of units). Embedded microprocessors can:

+ Use a full-featured RTOS
* Be driven by basic interrupts

+  Use rate monotonic scheduling provided with code generation

a. UNIX is a registered trademark of The Open Group in the United States and other countries.
b. Linux is a registered trademark of Linus Torvalds.

A target environment can:

+ Have single- or multiple-core CPUs

* Be a standalone computer or communicate as part of a computer network

In addition, you can deploy different parts of a Simulink model on different target
environments. For example, it is common to separate the component (algorithm or
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Target Environments and Applications

controller) portion of a model from the environment (or plant). Using Simulink to model
an entire system (plant and controller) is often referred to as closed-loop simulation and
can provide many benefits, such as early verification of a component.

The following figure shows example target environments for code generated for a model.

System model

I
I
I
|
I
Algorithm model Environment model !
I
I
I

Embedded Real-time
microprocessor simulator

Host
executable

Host computer(s)

Applications of Supported Target Environments

The following table lists several ways that you can apply code generation technology in
the context of the different target environments.

Application Description

Host Computer

“Acceleration” You apply techniques to speed up the
execution of model simulation in the
context of the MATLAB and Simulink
environments. Accelerated simulations
are especially useful when run time is
long compared to the time associated
with compilation and checking whether
the target is up to date.
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Application

Description

Rapid Simulation

You execute code generated for a model
in non-real-time on the host computer,
but outside the context of the MATLAB
and Simulink environments.

Shared Object Libraries

You integrate components into a
larger system. You provide generated
source code and related dependencies
for building a system in another
environment or in a host-based
shared library to which other code can
dynamically link.

Model Protection

You generate a protected model for
use by a third-party vendor in another
Simulink simulation environment.

Real-Time Simulator

Real-Time Rapid Prototyping

You generate, deploy, and tune code on
a real-time simulator connected to the
system hardware (for example, physical
plant or vehicle) being controlled. This
design step is crucial for validating
whether a component can control the
physical system.

Shared Object Libraries

You integrate generated source code

and dependencies for components into

a larger system that is built in another
environment. You can use shared library
files for intellectual property protection.

Hardware-in-the-Loop (HIL) Simulation

You generate code for a detailed design
that you can run in real time on an
embedded microprocessor while tuning
parameters and monitoring real-time
data. This design step allows you to
assess, interact with, and optimize
code, using embedded compilers and
hardware.
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Application

Description

Embedded Microprocessor

“Code Generation”

From a model, you generate code that

is optimized for speed, memory usage,
simplicity, and possibly, compliance with
industry standards and guidelines.

“Software-in-the-Loop (SIL) Simulation”

You execute generated code with your
plant model within Simulink to verify
conversion of the model to code. You
might change the code to emulate target
word size behavior and verify numerical
results expected when the code runs on
an embedded microprocessor. Or, you
might use actual target word sizes and
just test production code behavior.

“Processor-in-the-Loop (PIL) Simulation”

You test an object code component
with a plant or environment model in
an open- or closed-loop simulation to
verify model-to-code conversion, cross-
compilation, and software integration.

Hardware-in-the-loop (HIL) Simulation

You verify an embedded system or
embedded computing unit (ECU), using
a real-time target environment.
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“Controlling C Code Style” on page 2-9
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2 MATLAB Tutorials

Generate C Code from MATLAB Code

2-2

In this section...

“About MATLAB Coder” on page 2-2
“Getting Started Tutorials” on page 2-2

“Embedded Coder Capabilities for Code Generation from MATLAB Code” on page
2-3

About MATLAB Coder

MATLAB Coder generates standalone C and C++ from MATLAB code. The generated
source code is portable and readable. MATLAB Coder supports a subset of core MATLAB
language features, including program control constructs, functions, and matrix
operations. It can generate MEX functions that let you accelerate computationally
intensive portions of MATLAB code and verify the behavior of the generated code.

When generating C and C++ code from MATLAB code, follow this workflow.
How Embedded Coder Works With MATLAB Coder

The Embedded Coder product extends the MATLAB Coder product with features that
are important for embedded software development. Using the Embedded Coder add-
on product, you can generate code that has the clarity and efficiency of professional
handwritten code. For example, you can:

+  Generate code that is compact and fast, which is essential for real-time simulators,
on-target rapid prototyping boards, microprocessors used in mass production, and
embedded systems

+ Customize the appearance of the generated code
*  Optimize the generated code for application-specific requirements

+ Enable tracing options that help you to verify the generated code

See “Embedded Coder Capabilities for Code Generation from MATLAB Code” on page
2-3.

Getting Started Tutorials

The following tutorials will help you get started with using Embedded Coder to generate
code from MATLAB code for embedded system applications.



Generate C Code from MATLAB Code

* “Controlling C Code Style” on page 2-9

* “Tracing Between Generated C Code and MATLAB Code” on page 2-14
Prerequisites

To complete these tutorials, you must install the following products:

+ MATLAB

+ MATLAB Coder

* Embedded Coder

+  C compiler

For a list of supported compilers, see http://www.mathworks.com/support/
compilers/current_release/.

Before generating C code, you must set up the C compiler. See “Setting Up the C or C++
Compiler” in the MATLAB Coder documentation.

For instructions on installing MathWorks products, see the MATLAB installation
documentation for your platform. If you have installed MATLAB and want to see which
other MathWorks products are installed, in the Command Window, enter ver .

Setting Up Tutorial Files

The tutorial files are available in the following folder: matlabroot/help/toolbox/
ecoder/examples (open). To run the tutorials, copy these files to a local folder. Each
tutorial provides instructions about which files to copy and how to copy them.

Embedded Coder Capabilities for Code Generation from MATLAB Code

The Embedded Coder product extends the MATLAB Coder product with the following
options and optimizations for C/C++ code generation.

Godl Project Setting Code Configuration Object |More Information
Property

Speed

Control generation Support only PurelylntegerCode N/A

of floating-point data |purely-integer

and operations numbers

Code Appearance
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Goal

Project Setting

Code Configuration Object
Property

More Information

Specify use of single- |Comment Style CommentStyle “Specify Comment
line or multiline Style for C/C++ Code”
comments in the
generated code
Generate traceable MATLAB function |MATLABFcnDesc “Tracing Between
code that includes the |help text Generated C Code and
MATLAB function MATLAB Code” on
help text in the page 2-14
function banner
Convert if-elseif-else | Convert if-elseif- ConvertlfToSwitch “Controlling C Code
patterns to switch- else patterns Style” on page 2-9
case statements to switch-case

statements
Specify that the extern | Preserve extern PreserveExtern- N/A
keyword is included |keyword in function | InFcnDecls
in declarations of declarations
generated external
functions
Specify the level of Parentheses ParenthesesLevel N/A
parenthesization in
the generated code
Specify whether to Use signed shift EnableSignedLeftShif]“Control Signed Left
replace multiplications |left for fixed-point Shifts in Generated
by powers of two with |operations and Code”
signed left bitwise multiplication by
shifts in the generated |powers of 2
code
Specify whether to Allow right shifts on|EnableSignedRightShi|N/A
allow signed right signed integers
bitwise shifts in the
generated code
Control data type Casting mode on the |[CastingMode “Control Data Type

casts in the generated
code

All Settings tab

Casts in Generated
Code”
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Goal

Project Setting

Code Configuration Object
Property

More Information

Specify the indent Indent style on the IndentStyle “Specify Indent Style
style for the generated |All Settings tab IndentSize for C/C++ Code”
code Indent size on the
All Settings tab
Customize generated |Global variables CustomSymbolStr- “Customize Generated
global variable GlobalVvar Identifiers”
identifiers
Customize generated |Global types CustomSymbolStrType |“Customize Generated
global type identifiers Identifiers”
Customize generated |Field name of global |[CustomSymbolStrField|“Customize Generated
field names in global |types Identifiers”
type identifiers
Customize generated |Local functions CustomSymbolStrFcn |“Customize Generated
local functions Identifiers”
identifiers
Customize generated |Local temporary CustomSymbolStr- “Customize Generated
identifiers for local variables TmpVar Identifiers”
temporary variables
Customize generated |Constant macros CustomSymbolStrMacro|“Customize Generated
identifiers for constant Identifiers”
macros
Customize generated |EMX Array Types CustomSymbolStr- “Customize Generated
identifiers for EMXArray Identifiers”
EMX Array types
(Embeddable mxArray
types)
Customize generated |EMX Array Utility |CustomSymbolStrEMX- |“Customize Generated
identifiers for EMX Functions ArrayFcn Identifiers”
Array (Embeddable
mxArrays) utility
functions
Customize function Terminate function |IncludeTerminateFcn |N/A

interface in the
generated code

required
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that summarizes the
replacements used

replacement library

from the selected code

Goal Project Setting Code Configuration Object |More Information
Property
Customize file and N/A CodeTemplate * “Generate Custom
function banners File and Function
Banners for C/C++
Code”
* “Code Generation
Template Files for
MATLAB”
Control declarations |N/A N/A + “Storage Classes for
and definitions of Code Generation
global variables in the from MATLAB
generated code Code”
+ “Control
Declarations and
Definitions of Global
Variables in Code
Generated from
MATLAB Code”
Debugging
Generate a static Static code metrics |GenerateCodeMetrics-|“Generate a Static
code metrics report Report Code Metrics Report for
including generated MATLAB Code”
file information,
number of lines, and
memory usage
Generate a code Code replacements |GenerateCode- + “Replace Code
replacement report ReplacementReport Generated from

MATLAB Code”

+ “Review and Test
Code Replacements”
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Goal

Project Setting

Code Configuration Object
Property

More Information

Highlight single-

Highlight potential

HighlightPotential-

“Highlight Potential

precision, double- data type issues DataTypelssues Data Type Issues in a

precision, and Report”

expensive fixed-point

operations in the code

generation report

Custom Code

Replace functions Code replacement |CodeReplacement- Embedded Coder offers

and operators in the library Library additional libraries and

generated code to meet the ability to create and

application-specific use custom code. See

code requirements “Code Replacement”
and “Code Replacement
Customization”.

Create and register N/A N/A “Code Replacement

application-specific Customization”

implementations

of functions and

operators

Verification

Verify generated code |[N/A VerificationMode “Code Verification

using software-in-the- Through Software-

loop and processor-in- in-the-Loop and

the-loop execution Processor-in-the-Loop
Execution”

Debug code during Enable source-level [S1LDebugging “Debug SIL Execution”

software-in-the-loop  |debugging for SIL

execution on the Debugging

pane
Profile execution Enable entry point |CodeExecution- “Execution Time
times during software |execution profiling |Profiling Profiling”

-in-the-loop and
processor-in-the-loop
execution

for SIL/PIL on the
Debugging pane
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Verify and profile
ARM optimized code

Hardware Board on
the Hardware pane

Hardware

“PIL Execution with
ARM Cortex-A at
the Command Line”

“PIL Execution with
ARM Cortex-A by
Using the MATLAB
Coder App”
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Controlling C Code Style

In this section...

“About This Tutorial” on page 2-9

“Copy File to a Local Working Folder” on page 2-10
“Open the MATLAB Coder App” on page 2-10
“Specify Source Files” on page 2-10

“Define Input Types” on page 2-11

“Check for Run-Time Issues” on page 2-11
“Configure Build Parameters” on page 2-12
“Generate C Code” on page 2-12

“View the Generated C Code” on page 2-12
“Key Points to Remember” on page 2-13

“Learn More” on page 2-13

About This Tutorial

Learning Obijectives
This tutorial shows you how to:

* Generate code for i f-elseif-else decision logic as switch-case statements.
*  Generate C code from your MATLAB code using the MATLAB Coder app.
+  Configure code generation configuration parameters in the MATLAB Coder project.

* Generate a code generation report that you can use to view and debug your MATLAB
code.

Required Products

This tutorial requires the following products:

- MATLAB
+ MATLAB Coder

*  C compiler
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For most platforms, a default compiler is supplied with MATLAB.

MATLAB Coder locates and uses a supported installed compiler. See Supported and
Compatible Compilers on the MathWorks website.

You can use mex -setup to change the default compiler. See “Change Default
Compiler”.

For instructions on installing MathWorks products, see the MATLAB installation
documentation for your platform. If you have installed MATLAB and want to check
which other MathWorks products are installed, at the prompt, enter ver.

Required Files

Type Name Description

Function code test_code_style.m MATLAB example that uses
if-elseif-else.

Copy File to a Local Working Folder

1 Create a local working folder, for example, c:\ecoder\work.

2 Change to the matlabroot\help\toolbox\ecoder\examples folder. At the
MATLAB command prompt, enter:

cd(fullfile(docroot, "toolbox®, "ecoder®, “"examples®))
3 Copy the file test_code_style.m to your local working folder.

Open the MATLAB Coder App

On the MATLAB Toolstrip Apps tab, under Code Generation, click the MATLAB
Coder app icon.

The app opens the Select Source Files page.

Specify Source Files

1 On the Select Source Files page, type or select the name of the entry-point
function test_code_style.m.
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2 In the Project location field, change the project name to code_style.prj.

3 Click Next to go to the Define Input Types step. The app analyzes the function for
coding issues and code generation readiness. If the app identifies issues, it opens the
Review Code Generation Readiness page where you can review and fix issues.
In this example, because the app does not detect issues, it opens the Define Input

Types page.

Define Input Types

Because C uses static typing, at compile time, MATLAB Coder must determine the
properties of all variables in the MATLAB files. Therefore, you must specify the
properties of all function inputs. To define the properties of the input x:

Click Let me enter input or global types directly.

Click the field to the right of x.

From the list of options, select intl6. Then, select scalar.

AW N —

Click Next to go to the Check for Run-Time Issues step.

Note: The Convert if-elseif-else patterns to switch-case statements
optimization works only for integer and enumerated type inputs.

Check for Run-Time Issues

The Check for Run-Time Issues step generates a MEX file from your entry-point
functions, runs the MEX function, and reports issues. This step is optional. However,

it is a best practice to perform this step. Using this step, you can detect and fix run-
time errors that are harder to diagnose in the generated C code. By default, the MEX
function includes memory integrity checks. These checks perform array bounds and
dimension checking. The checks detect violations of memory integrity in code generated
for MATLAB functions. For more information, see “Control Run-Time Checks”.

1 To open the Check for Run-Time Issues dialog box, click the Check for Issues

arrow n

2 Inthe Check for Run-Time Issues dialog box, enter code that calls
test_code_style with an example input. For this example, enter
test_code_style(intl6(4)).
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4

Click Check for Issues.

The app generates a MEX function. It runs the MEX function with the example
input. If the app detects issues during the MEX function generation or execution,
it provides warning and error messages. Click these messages to navigate to the
problematic code and fix the issue. In this example, the app does not detect issues.

Click Next to go to the Generate Code step.

Configure Build Parameters

1

AW

To open the Generate dialog box, click the Generate arrow ﬂ
Set the Build type to Static Library (.lib).
Click More settings.

On the Code Appearance tab, select the Convert if-elseif-else patterns to
switch-case statements check box.

On the Debugging tab, verify that Always create a code generation report is
selected, and then click Close.

Generate C Code

Click Generate.

When the code generation is complete, MATLAB Coder generates a C static library,
test _code_style.lib, and C code in the /codegen/lib/test_code_style
subfolder. Because you selected report generation, MATLAB Coder provides a link to the
report.

View the Generated C Code

MATLAB Coder generates C code in the file test _code_style.c.

To view the generated code:

1

On the Generate Code page, under Output Files, click test _code_style.c.
In the code window, you can see that in the C code, the switch-case statement
replaces the i f-elseif-else pattern.

switch (xX) {
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case 1:
y =1.0;
break;

case 2:
y = 2.0;
break;

case 3:
y = 3.0;
break;

default:
y = 4.0;
break;

}

2 Click Next to open the Finish Workflow page.

The Finish Workflow page indicates that code generation succeeded. It provides a
project summary and links to the generated output.

Key Points to Remember

*  To check for run-time issues before code generation, perform the Check for Run-

Time Issues step.

* To access build configuration settings, on the Generate Code page, open the
Generate dialog box, and then click More Settings.

Learn More

To

See

Learn how to generate C/C++ code using the
MATLAB Coder app.

“C Code Generation Using the MATLAB Coder
App”

Learn how to generate C/C++ code using
MATLAB code using the command-line
interface.

“C Code Generation at the Command Line”
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Tracing Between Generated C Code and MATLAB Code
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In this section...

“About This Tutorial” on page 2-14

“Copying Files Locally” on page 2-15

“Configuring Build Parameters” on page 2-15
“Generating the C Code” on page 2-16

“Viewing the Generated C Code” on page 2-16

“Tracing Back to the Source MATLAB Code” on page 2-17
“Key Points to Remember” on page 2-17

“Learn More” on page 2-17

About This Tutorial

Learning Obijectives
This tutorial shows you how to:

*  Generate code that includes the MATLAB source code as comments.
* Include the function help text in the function header of the generated code.

+  Use the code generation report to trace from the generated code to the source code.

Prerequisites

To complete this tutorial, install the required products and set up your C compiler as
described in “Prerequisites” on page 2-3

Required File

Type Name Description

Function code polar2cartesian.m Simple MATLAB function
that contains a comment

To run the tutorial, copy this file to a local folder. For instructions, see “Copying Files
Locally” on page 2-15.
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Copying Files Locally

Copy the tutorial file to a local working folder.

Create a local working folder, for example, cz\ecoder\work.

2 Change to the matlabroot\help\toolbox\ecoder\examples folder. At the
MATLAB command line, enter:
cd(fullfile(docroot, “toolbox®, "ecoder®, “"examples®))

3 Copy the polar2cartesian.mfile to your local working folder.

Your work folder now contains the file you need to complete this tutorial.

4  Set your MATLAB current folder to the work folder that contains the file for this
tutorial. At the MATLAB command line, enter:

cd work
where work is the full path of the work folder containing your files.

Contents of polar2cartesian.m

function [x y] = polar2cartesian(r,theta)
%#codegen

% Convert polar to Cartesian

X r * cos(theta);

y r * sin(theta);

Configuring Build Parameters
1 Create a coder.EmbeddedCodeConfig code generation configuration object.

cfg = coder.config("lib", "ecoder”, true);

2 Enable the MATLABSourceCode option to include MATLAB source code as
comments in the generated code and the function signature in the function banner.

cfg_MATLABSourceComments = true;

3 Enable the MATLBFcnDesc option to include the function help text in the function
banner.

cfg_MATLABFcnDesc = true;
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Generating the C Code

Call the codegen function to generate C code, with the following options:

+ -config to pass in the code generation configuration object cfg.
* -report to create a code generation report.

* —args to specify the class, size, and complexity of the input parameters.

codegen -config cfg -report polar2cartesian -args {0, 0}
codegen generates a C static library, polar2cartesian. lib, and C code in the /

codegen/lib/polar2cartesian subfolder. Because you selected report generation,
codegen provides a link to the report.

Viewing the Generated C Code
codegen generates C code in the file polar2cartesian.c

To view the generated code:

Click the View report link to open the code generation report.
2 In the report, click the C code tab.
3  On this tab, click the polar2cartesian.c link.

Examine the generated code. The function help text Convert polar to

Cartesian appears in the function header. The source code appears as comments in

the generated code.

/*

* function [x y] = polar2cartesian(r,theta)

* Convert polar to Cartesian

*/

void straightline(real _T r, real_T theta,
real _T *x, real _T *y)

{
/* "polar2cartesian:4® x = r * cos(theta); */
*X = r * cos(theta);
/* "polar2cartesian:5" y = r * sin(theta); */
*y = r * sin(theta);

3
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Tracing Back to the Source MATLAB Code

To trace back to the source code, click a traceability tag.

For example, to view the MATLAB code for the C code, x = r * cos(theta);, click
the "polar2cartesian:4~ traceability tag.

The source code file polar2cartesian.mopens in the MATLAB editor with line 4
highlighted.

Key Points to Remember

+ Create a coder .EmbeddedCodeConTig configuration object and enable the:
MATLABSourceCode option to include MATLAB source code as comments in the
generated code and the function signature in the function banner

MATLBFcnDesc option to include the function help text in the function banner

+ Use the —config option to pass the code generation configuration object to the
codegen function.

* Use the —report option to create a code generation report.

+ Use the —args option to specify the class, size, and complexity of input parameters.

Learn More
To... See...
Learn more about code traceability “Code Traceability”
Learn about the location of comments in the “Location of Comments in Generated Code”
generated code
See traceability limitations “Traceability Limitations”
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* “Generate C Code from Simulink Models” on page 3-2

+ “Configure a Model for Code Generation” on page 3-6

* “Generate and Analyze C Code” on page 3-11

* “Customize Code Appearance” on page 3-22

+ “Customize Function Interface and File Packaging” on page 3-27
* “Define Data in the Generated Code” on page 3-33

* “Deploy and Verify Executable Program” on page 3-41

+ “Embedded Coder Documentation” on page 3-48
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Generate C Code from Simulink Models

3-2

In this section...

“Prerequisites” on page 3-2

“Example Models in Tutorials” on page 3-2

Embedded Coder generates readable, compact, and fast C and C++ code for use on
embedded processors, on-target rapid prototyping boards, and microprocessors used in
mass production. You can generate code for a wide variety of applications. These tutorials
focus on real-time deployment of a discrete-time control system. The tutorials include
how to:

+ “Configure a Model for Code Generation” on page 3-6

+ “Generate and Analyze C Code” on page 3-11

* “Customize Function Interface and File Packaging” on page 3-27

*  “Define Data in the Generated Code” on page 3-33

* “Customize Code Appearance” on page 3-22

* “Deploy and Verify Executable Program” on page 3-41

Prerequisites

To complete these tutorials, you must install the following products:

- MATLAB
* MATLAB Coder
*  Simulink
*  Simulink Coder

+ Embedded Coder

Example Models in Tutorials

The code verification and validation process depends on your model meeting your
requirements and exactly representing your design. Functionality in the model must
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be traceable back to model requirements. You can use reviews, analysis, simulations,
and requirements-based tests to prove that your original requirements are met by
your design and that the design does not contain unintended functionality. Performing
verification and validation activities at each step of the process can reduce expensive
errors during production.

The Embedded Coder tutorials use the rtwdemo_roll model, which has been verified for

simulation. To open the model, in the Command Window, type:

rtwdemo_roll

The model opens in the Simulink Editor.

L7} | Pi_Ref
HDG Ref Roll Axis Autopilot Model
{2} o Psi Phi_Crmd Copyright 1990-2014 The MathWerks, Inc.
Psi
=D p{ 785
TAS
Headi
eadinghiode
=D > Disp_Cmd
. phiCmd -
HDG_Mode
— ModeSw itch
L1 Disp_FB
Fhi Surf_Cmd
. Rate 75
| Fhi s
D' plar Eng  Phi Rer Engaged
AP_Eng -
- o Turn_knob BasicRellVode

Turn_Knob

RollsngleR eference

DOoC
Teaxt

System /O
Specification

The rtwdemo_rol I model implements a basic roll axis autopilot algorithm, which
controls the aileron position of an aircraft.
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Aileron

Aileron

CLOSE UP OF WING

Aileron

There are two operating modes: roll attitude hold and heading hold. The mode

logic for these modes is external to this model. The model architecture uses atomic
subsystems to represent the roll angle reference (Rol lAngleReference), heading hold
mode (HeadingMode), and basic roll attitude (BasicRol IMode) functions as atomic
subsystems. The roll attitude control function is a PID controller that uses roll attitude
and roll rate feedback to produce an aileron command. The input to the controller is
either a basic roll angle reference or a roll command to track the desired heading. The
controller operates at 40 Hz.

Two additional models are provided for the Embedded Coder tutorials:
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+ rtwdemo_roll_codegen: This model is rtwdemo_rol I configured for code
generation with optimizations applied according to the code generation objectives.

* rtwdemo_roll_harness: This model is a harness model to test
rtwdemo_roll_codegen.

To begin the tutorials for code generation, see the first example, “Configure a Model for
Code Generation” on page 3-6.
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Configure a Model for Code Generation

In this section...

“Solver for Code Generation” on page 3-6
“Code Generation Target” on page 3-7
“Check Model Configuration” on page 3-8

Model configuration parameter settings determine how a model simulates and how the
software generates code and builds an executable for the model. You specify the model
configuration parameters on the Configuration Parameters dialog box or at the command
line. The settings in the Configuration Parameters dialog box specify the model's active
configuration set, which is saved with the model.

When generating code for an embedded system, choosing the model configuration
settings can be complex. At a minimum, you must configure the solver, system target file,
hardware implementation, and optimizations according to your application requirements.

Solver for Code Generation

To prepare the model for generating C89/C90 compliant C code:
1 If rtwdemo_roll is not already open, in the Command Window, type:

rtwdemo_roll
2 Save the model to a local folder as rol I .slx.

3 To open the Configuration Parameters dialog box, on the Simulink Editor toolbar,
click the Model Configuration Parameters icon.

© -~

4 In the Configuration Parameters dialog box, in the left navigation pane, select the
Solver pane.

To generate code, the model must use a fixed-step solver, which maintains a constant

(fixed) step size. In the generated code, the Solver parameter applies a fixed-step
integration technique for computing the state derivative of the model. The Fixed-step
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size parameter sets the base rate, which must be the lowest common multiple of all rates
in the system. For rol I, the following solver settings are selected.

Simulation time

Start time: 0.0 Stop time: 30

Solver options

Type: |Fixed-step '] Salver: [discrete {no continuous states) -

¥ Additional options

Fixed-step size (fundamental sample time): 0.025

Code Generation Target

To specify a target configuration for the model, you can choose a ready-to-run Embedded
Real-Time Target (ERT) configuration. The code generator uses this target file to
generate code that is optimized for embedded system deployment.

In the Configuration Parameters dialog box, select the Code Generation pane.

2 To open the System Target File Browser dialog box, click the System target file
parameter Browse button. The System Target File Browser dialog box includes
a list of available targets. This example uses the system target file ert.tlc
Embedded Coder, which is already set.

System Target File: Description:

azapz.tlc ASBM-ASAPZ Data Definition Target

autosar.tlec AUTOSAR

ert.tlc Embedded Coder

ert.tlc Create Visual C/C++ Solution File for Embedded Coder
ert _shrlib.tlc Embedded Coder (host-based shared library target) E
grt.tlc Generic Real-Time Target

grt.tlc Create Visual C/C++ Solution File for Simulink Coder
idelink ert.tlc IDE Link ERT

idelink grt.tlc IDE Link GRET

realtime.tlc Run on Target Hardware

rzim.tlc Eapid S5imumlation Target
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3 In the System Target File Browser dialog box, click OK.

Check Model Configuration

When generating code for real-time deployment, your application might have objectives
related to code efficiency, memory usage, safety precaution, and traceability. You can run
the Code Generation Advisor to assess whether the model configuration settings meet
your set of prioritized objectives. After running the advisor, you get information on how
to modify your model configuration parameters to meet the specified objectives.

Set Code Generation Obijectives with Code Generation Advisor

1 In the Configuration Parameters dialog box, select the Code Generation pane.

2 Click Set Objectives.

3 In the Select Objectives dialog box, the following objectives are in the Selected
objectives — prioritized list in the following order: Execution efficiency,
Traceability, Safety precaution, and RAM efficiency.

Set Objectives - Code Generation Sdwvisor £3
Description
Select and prioritize your code generation objectives, You can add custom
objectives, for details, see the documentation.
Available objectives Selected objectives - prioritized
ROM efficiency Execution efficiency
Debugging Traceability
MISRA C:2012 guidelines Safety precaution
+

Polyspace RaM efficiency

E

[+

| oK || Cancel || Help

4 Click OK. In the Configuration Parameters dialog box, the selected objectives are
shown in the Prioritized objectives list.
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Code generation objectives

Prioritized objectives: Execution efficiency, Traceability, Safety precaution, ... [ Set Objectives...

Check model before generating code: [OFF Y] [ Check Model...

Check Model Against Code Generation Objectives

1

In the Configuration Parameters dialog box, on the Code Generation pane, click
Check Model.

In the System Selector dialog box, click OK to run checks on roll.

4 @ Code generation objectives

& Chedk model configuration settings against code generation objectives

o Identify unconnected lines, input ports, and output ports

o Check for optimal bus virtuality

a Check Data Store Memaory blocks for multitasking, strong typing, and shadowing issues
a ~Identify block output signals with continuous sample time and non-floating point data
o Identify questionable blodks within the spedified system

o Check the hardware implementation

a Identify guestionable software environment spedifications

Identify questionable code instrumentation (data Ij0)

“~Check for blocks that have constraints on tunable parameters

~Identify guestionable subsystem settings

~Identify blocks that generate expensive rounding code

~Identify questionable fixed-point operations

SO0000

Identify blocks using one-based indexing

o Identify lookup table blocks that generate expensive out-ofrange checking code
a Check output types of logic blocks

& ~Identify blocks that generate expensive fixed-point and saturation code

View Model Configuration Recommendations

In the Code Generation Advisor window:

The Code Generation Advisor window opens. After the advisor runs, in the left pane,
there are two warnings indicated by yellow triangles.
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1 In the left pane, click Check model configuration settings against code
generation objectives.

2 In the right pane, review the recommendations for the configuration parameters in
the table.

3 To change the configuration parameters that caused the warnings to the software-
recommended settings, click Modify Parameters. The Result table displays the
parameters and changed values. Clicking a parameter name displays Configuration
Parameters dialog box pane where the parameter exists.

4 In the left pane, click the next warning for Identify blocks that generate
expensive fixed-point and saturation code.

5 In the right pane, find the warning, Identify Discrete Integrator blocks for
questionable fixed-point operations. Under the warning, click the link to the
Integrator block.

In the Simulink Editor, the Integrator block is highlighted in blue.

6 Right-click the Integrator block and in the list, select Block
Parameters(Discretelntegrator).

7 In the Block Parameter dialog box, set the Initial condition setting to State
(most efficient).

Initial condition:

0

Initial condition setting: | Output

Sample time (-1 for inh

1/40 Compatibility

Limit output

8 Click Apply and OK.

9 Save your model.

The example model rtwdemo_roll_codegen contains the modifications made in this
example to rtwdemo_rol l. The next example shows how to generate code, examine the
code, and trace between the code and model. See “Generate and Analyze C Code” on page
3-11.
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Generate and Analyze C Code

In this section...

“Generate Code” on page 3-11
“Analyze the Generated Code” on page 3-13
“Trace Between Code and Model” on page 3-19

After configuring your model for code generation, you generate and view the code. To
analyze the generated code, you can generate an HTML code generation report that
provides a view of the generated code and information about the code. This example uses
the configured model rol I from the example, “Generate and Analyze C Code” on page
3-11. For this example, open rtwdemo_roll_codegen and save it to a local folder as
roll.slIx.

Generate Code

Before generating code, you can specify that the code generation process generates an
HTML report that includes the generated code and information about the model. This
information helps you to evaluate the generated code.
Open the Configuration Parameters dialog box.
2 In the left navigation pane, select the Code Generation > Report pane.
3 Observe the selected parameters that create a code generation report and include
traceability between the code to the model.
+ “Create code generation report”
“Open report automatically”
“Code-to-model”
+  “Model-to-code”, which enables the Traceability Report Contents parameters.

4 To include static code metrics in the code generation report, confirm that “Static code
metrics” is selected.
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Create code generation report Open report automatically
Mavigation
Code-to-model

Model-to-code

[] Generate model Web view

Traceability Report Contents
Eliminated [ virtual blocks
Traceable Simulink blocks
Traceable Stateflow objects
Traceable MATLAB functions

Metrics

Static code metrics

5 On the Code Generation pane, select the Generate code only check box.
6 Click Apply.
7 Press Ctrl+B to generate code.

After the code generation process is complete, the HTML code generation report opens.
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Code Generation Report EI@
& Find: 4+ % Match Case
Contents H 1 1
Code Generation Report for 'roll
Summary
Subsystem Report Summary
Code Interface Report Code generation for model "roll”
Traceability Report
Static Code Metrics Report JItzlvaETr LB
Simulink Coder version 8.10 (R2016a) 21-Dec-2015
Code Replacements Report C source code generated on Mon Dec 28 14:41:46 2015
C source code generated at H:\Documents\MATLAB\roll_ert_rtw\
Generated Code
[~1 Main file Configuration settings at the time of code generation: click to open
ert main.c Code generation objectives:
-1 Model files 1. Execution efficiency
roll.c 2. Traceability ]
3. Safety precaution
roll.h 4. RAM efficiency
roll_private.h
Validation result: Not run
roll_types.h

[+] Shared files (1)

Note: If you close the code generation report, you can reopen the report from the
Simulink Editor by selecting the menu option: Code > C/C++ Code > Code Generation
Report > Open Model Report.

Analyze the Generated Code

The code generation process places the source code files in the build folder
roll_ert_rtw. The HTML code generation report files are placed in the
roll_ert_rtw/html folder. The code generation report includes the generated code and
several reports that provide information for evaluating the generated code. The following
sections describe each of these reports:
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3-14

* “Subsystem Report” on page 3-14

* “Code Interface Report” on page 3-15

+ “Traceability Report” on page 3-16

+ “Static Code Metrics Report” on page 3-18
+ “Code Replacements Report” on page 3-18
* “Generated Code” on page 3-18

Subsystem Report

To open the subsystem report, in the left pane of the code generation report, click
Subsystem Report. You can implement nonvirtual subsystems as inlined, void/void
functions, or reusable functions. In the subsystem report, you can view information on
how nonvirtual subsystems are configured in the model and implemented in the code. In
the Code Mapping section, the subsystem report provides traceability from the table
to the Subsystem block in the model. The table includes information about whether a
subsystem is configured for reuse and if the subsystem function code is reused.

Non-virtual subsystems in roll

1. Code Mapping [hide

The following table:

& provides a mapping from the non-virtual subsystems in the model to functions or
reusable functions in the generated code and

& notes exceptions that caused some non-virtual subsystems to not reuse code aven
though they were assigned a function packaging setting ('Function packaging' entry
on the Subsystem Block Dialog) of 'Auto' or 'Reusable function'.

Subsystem Reuse Setting Reuse Outcome Outcome Diagnostic
=52> Inline Inline normal
=51> Inline Inline norma
=53 Inline Inline normal

The Code Reuse Exceptions section provides information on subsystems configured for
reuse, but code reuse does not occur. For this model, there are no reuse exceptions.
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Code Interface Report

The code interface report provides documentation of the generated code interface for
consumers of the generated code. The generated code interface includes model entry
point functions and interface data. The information in the report can help facilitate
code reviews and code integration. There are potentially three entry point functions to
initialize, step, and terminate the real-time capable code. The code generated for this
model has an initialize and step function.

Entry Point Functions

Function: roll_initialize

Prototype void roll_initialize(void)

Description Initialization entry point of generated code
Timing Must be called exactly once

Arguments Mone

Return value None

Header file roll.h

Function: roll_step

Prototype void roll_step(void)

Description Output entry point of generated code

Timing Must be called periodically, every 0.025 seconds
Arguments Mone

Return value None

Header file roll.h

For roll, the Inports and Outports sections include block names that you can click to
navigate to the corresponding block in the model. The other columns in the table include
the name for the block, the data type, and dimension as it is represented in the generated
code.
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Inports

[

Block Name Code ldentifier Data Type Dimension
<Root=/Phi roll_U.Phi real32_T 1
<Root=/Psi roll_U.Psi real32_T 1
<Root=>/P roll_U.P real32_T 1
<Root=/TAS roll_U.TAS real32_T 1
<Root=/AP Eng roll_U.AP Eng boolean_T 1
<Root=/HDG Mode roll_U.HDG_Mode boolean_T 1
<Root=/HDG_Ref roll_U.HDG_Ref real32_T 1
<Root=/Turn Knob roll_U.Turn_Knob real32_T 1
Outports

Block Name Code Identifier Data Type Dimension
<Root=/Ail Cmd roll_Y.Ail_Cmd real32_T 1

Traceability Report

To map model objects to and from the generated code, open the traceability report. The
Eliminated / Virtual Blocks table lists objects that are virtual or eliminated from the
generated code due to an optimization.

<53=/Tum_ Knob Inport
<53=/LatchPhi Masked SubSystem
<53=/ System 1I//0 Specification Masked SubSystem
<53=/FPhi Ref Qutport
<54=/FEmptySubsystem Empty SubSystem

In the Traceable Simulink Blocks / Stateflow Objects / MATLAB Functions table,
click an Object Name to highlight the object in the model diagram. You can also click
the corresponding Code Location, which displays the generated code for that object.

3-16



Generate and Analyze C Code

Traceable Simulink Blocks / Stateflow Objects /f MATLAB Functions

Root system: roll

Object Name Code Location
<Root=/Phi roll.c:51, 127
roll.h:41
<Root>/Psi roll.c:74
roll.h:42
<Root=/P roll.c:143
roll.h:43
<Root>/TAS roll.c:75
roll.h:44
<Root>/AP_Eng roll.c:43, 100, 172
roll.h:45
<Root>/HDG_Mode roll.c:72
roll.h:46
<Root>/HDG_Ref roll.c:73
roll.h:47
<Root>/Turn Knob roll.c:76
roll.h:48

<Root>/BasicRollMode
<Root>/EngSwitch
<Root>/HeadingMode
<Root>/ModeSwitch
<Root>/RollAngleReference

<Root>/Fero
<Root=/Ail Cmd

roll.c:98, 169, 175, 188
roll.c:171, 196

roll.c:83, 86

roll.c:68, 96
roll.c:38, 66, B8, 93
roll.c:191

roll.c:178, 182, 190
roll.h:53
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Static Code Metrics Report

You can monitor code metrics as you develop your model and refine its configuration.
The code generator performs static analysis of the generated C code and provides

these metrics in the static code metrics report. Static analysis of the generated code is
performed only on the source code without executing the program. Information in the
report includes metrics on files, global variables, and functions. For example, the Global
Variables table includes information for each global variable: size, number of reads and
writes, and number of reads and writes in a function.

2. Global Variables [hide]

Global variables defined in the generated code.

Global Variable Size (bytes) Reads / Writes Reads / Writesin a

Function
[+] roll_U 26 14 14
[+] roll_DW 9 17 17
[+] roll_Y 4 4 a
Total 35 35

3-18

Code Replacements Report

You can use the code replacements report to determine which code replacement library
(CRL) functions you use in the generated code. The report includes traceability from each
replacement instance back to the block that triggered the replacement. For this model, no
code replacement library is specified.

Generated Code

You can view the generated code source files in the code generation report. Click the

file names in the left navigation pane. The generated model .c file roll .c contains the
algorithm code, including the ODE solver code. The model data and entry point functions
are accessible to a caller by including rol I _h. In the left navigation pane, click roll.h
to view the extern declarations for block outputs, continuous states, model output, entry
points, and timing data.
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-

"% Code Generation Report

L@

Find:
Contents

Summary

Subsystem Report
Code Interface Report
Traceability Report

Static Code Metrics Report

Code Replacements Report

‘Generated Code
[-1 Main file
Ert_main.c

[ -1 Model files

roll.c

roll.h

roll private.h
roll types.h

[+] Utility files (1)

i

[LoS FURNL PR SR PV P SV
O =] oy (1 b

fy by

[
oo

m

v o bka

oy

in in fn tn in in o tn (n i fn b
[ o .

oy oy ooy oy o
Gy by koo

T

4p W Match Case

CYPCUCL JTIuote |
realSZ_T FithUnitDelayl_DSTATE;
realSZ_T Integrator_DSTATE;
:'LntS_'E Integrator_PrevResetState;
} DW_roll T:

/* External inputs (root inport signals with aute storags) */

typedef struct {
real3? T Phi;
real3? T Psi;
real3? T F;
realSZ_T TLS;
boolean_T AF_Eng;
boolean_T HDG_Mode;
real3l? T HDG Ref;
real3? T Turn EKnob;

} ExtU roll T;

/* External outputs (root outports fed by signals with avte storag

typedef struct {
real3? T Ail Cmd;
} ExtY roll T:

/* '"sRoot>/Phi" */

/* '<Root»/Psi’ */

S+ '"sRoot»/B' +/

S* '<Root>/TAS" +*/

Ve '<Root>/AF Eng’ *4
S ’(Roo':>{HDS_Mode’ * 4
/* '<Root>/HDG Ref' */
/* '<xRoot>/Turn Kneb' */

/* '<Rootx/A7i] Cmd' */

J/#* Block signals and states (auto storags) */

extern DW roll T roll LW

/* External inputs (root inport signals with aute storags) */

extern ExtU roll T roll O;

/* External outputs (root outports
extern Ext¥ roll T roll ¥;

/% Model entry point functions #/
extern void roll initialize (void):

extern void roll step(void):

SE—

=,

L)

m

fed by signals with auto storag

Trace Between Code and Model

To verify the generated code, you can specify that your model generates hyperlinks in
the source code in the code generation report. The hyperlinks trace to the corresponding
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element in the model. For this example, rol 1 is set up to include traceability. To enable
traceability and generate hyperlinks the following parameters must be selected:

* On the Code Generation > Report pane:

“Code-to-model”
“Model-to-code”

* On the Code Generation > Comments pane:

“Include comments”

“Simulink block / Stateflow object comments”
Trace from Model to Code

To trace from roll to the code generation report, in the Simulink Editor, right-click the
HeadingMode subsystem. From the menu list, select C/C++ code > Navigate to C/C++
code. In the code generation report, the source code for Head ingMode is highlighted.

if (roll U.HDG Mode) {

A* Outputs for Atomic SubSystem: "<Root>/HeadingMode'™ */
rtb phiCmd = (roll U.HDG REef - roll U.Psi) * 0.015F * roll U.TAS;
A* End of Cutputs for SubSystem: "<Root>/HeadingMode'™ */

Trace from Code to Model

To trace from the code generation report to the model, in the left navigation pane of

the code generation report, select roll .c. Comments in the code contain underlined
text that are hyperlinks to the model. For example, when you click the hyperlink for
RollAngleReference:

A* Qutputs for Atomi ubSvstem: '<Root> /AollingleRefsrsncs’ */
S =

c 5u
A* UnitDelav '57>/F1XFP

T _. M= r &
t D=elavl *

F1thU11tDElEyl DSTATE = roll DHW.FixPtUnitDelayl DSTATE:

the RollAngleReference subsystem is highlighted in the Simulink Editor.
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[-180..180]
7} | F=i_Ref
HDG_Ref Roll Axis Autopilot Model
[-180..180] ) )
l: 2 } » P=i Phi_Cmd Copyright 1990-2013 The MathWorks, Inc
Psi
[0..1000] poc
4 3 o TAS Texd|
TAS - System 1O
[0.1] Headinghiode T F180. 150] Specification
(8 ) »H — » Digp_Crmd
)|
HDG_Mode Eer e
- Mode Sw itch
o »|viss_Fe
[-180..180] -15..15]

Phi

[4£0..560] Surf_Cmd

T
e [-15..15]

L

sy -1 [-180.. 18] p|Engaged E_’—l':

#|AP_Eng  PhiRef Zero  EngSwitch

5
&

[-45..45]

- » I |I | BasicRoliMode
Turn_Knob

RaollAngleR eference

After reviewing the reports and analyzing the generated code, you can change the
appearance of the generated code according to defined style standards. To change the
generation of comments, identifiers, and code style, see the next example, “Customize
Code Appearance” on page 3-22.
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Customize Code Appearance

In this section...

“Comments” on page 3-22
“Identifiers” on page 3-23
“Code Style” on page 3-25

Modifying the code appearance helps you to adhere to your coding standards and
enhance the readability of the code for code reviews. You can change the appearance

of the generated code by specifying comment style, customizing identifier names, and
choosing from several code style parameters. This example uses the configured model
roll from the example, “Generate and Analyze C Code” on page 3-11. For this example,
open rtwdemo_roll_codegen and save it to a local folder as roll.slx.

Comments

To customize the appearance of comments in the generated code for model roll, open
the Configuration Parameters dialog box and select the Code Generation > Comments
pane.

Overall control

¥ Include comments

Auto generated comments

J| Simulink block / Stateflow object comments

J| MATLAB source code as comments

¥| Show eliminated blocks

J| Verbose comments for SimulinkGlobal storage class

/| Operator annotations

In the model roll, “Include comments” is selected to include comments in the generated
code and enable the other comment parameters. If you configured your model for
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traceability, enabling comments provides traceability hyperlinks in the generate code
comments.

The Custom comments group of parameters provides additional options for controlling
specific comments for model elements.

Custom comments

¥| Simulink block descriptions | Stateflow object descriptions
¥| Simulink data object descriptions | Requirements in block comments
¥| Custom comments (MPT objects only) | MATLAB function help text

Custorm comments function:

Identifiers

To customize the appearance of identifiers in the generated code, in the Configuration
Parameters dialog box, select the Code Generation > Symbols pane. The Auto-
generated identifier naming rules group of parameters allows you to include a string
of predefined tokens to customize the generated identifier names. In the model roll, the
tokens specified are the default values.
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Auto-generated identifier naming rules

Identifier format control

Global variables: SREMEM
Global types: SNSRSM_T
Field name of global types: SNEM
Subsystem methods: SRENEMEF

Subsystem method arguments: rtSIENEM
Local temporary variables: ENEM

Local block output variables: rth_SMEM

Constant macros: SREMNEM

Shared utilities: SNEC
Minimum mangle length: 1
Maximum identifier length: 31
System-generated identifiers: lShnr‘tened

Generate scalar inlined parameters as: lLiteraIs

Common tokens to include are:

+ $M: The $M token is a name mangling string to avoid naming collisions. The position
of the $M token determines the position of the name mangling string in the generated
identifier. For most of the variables that you customize, this token is required in the
specification. The Minimum mangle length parameter determines the size of the
mangling string.

*  $N: This token includes the name of a model object (block, signal or signal object,
state, parameter, shared utility function, or parameter object) for which the identifier
is being generated.

*  $R: This token inserts the root model name into the identifier. When you use
referenced models, this token is required.
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For example, in the roll model, the Local block output variables is specified with an
rtb prefix.

1 If the code generation report is not open, generate code for the rol'l model.
2 Inthe HTML code generation report, in the left navigation pane, select roll.c.
3 At the top of the window, in the Find box, type rtb and press Enter.

Variables beginning with rtb are highlighted in the report.

Code Generation Report [=]
2l p
& Find: rb 4p % Match Case
Contents -
32 /+* Model step function */

Ly
n

volid roll step(void)

i
boolean T m_NOtEngaged_f;
real32 T rtb FixPtUnitDelayl:

Summary

Ly

Subsystem Report

Ly

Ly
oy

Code Interface Report

[
1

Traceability Report

38 * Outputs for Atomic SubSystem '¢Roct>/RolliAngleRefersnce "’ *
Static Code Metrics Report 3 /+ UnitDelay: '<S7>/FixPt Unit Delayl® *

Code Replacements Report 4C

Generated Code

[~]1 Main file by ¢ Logic
ert_main.c 45 */
) 45 if (!roll U.AFP Eng) {
[-]1 Model files ) . . .
47 S* Switch: '<S83>/RefSwibtch' incorporates
roll.c . . ,
roll.h 49 " .

4 To navigate between instances, use the up and down arrows in the code generation
report.

Code Style

To customize the appearance of the generated code, in the Configuration Parameters
dialog box, click the Code Generation > Code Style pane.
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Code style

Parentheses level: INominaI (Optimize for readability) A

[C] Preserve operand order in expression

[C] Preserve condition expression in if statement

Convert if-elseif-else patterns to switch-case statements

Preserve extern keyword in function declarations

Suppress generation of default cases for Stateflow switch statements if unreachable
Replace multiplications by powers of two with signed bitwise shifts

Allow right shifts on signed integers

Casting modes: Nominal -

Code indentation

Indent style: |[K&R - Indent size: |2 ~

The parameters allow you to control the following code styles:

* Level of parenthesization
* Order of operands in expressions
*  Empty primary condition expressions in i1 F statements

*  Whether to generate code for i F-elseif-else decision logic as switch-case
statements

*  Whether to include the extern keyword in function declarations

* Whether to generate default cases for switch-case statements in the code for
Stateflow charts

*  How to specify casting for variable data types in the generated code
*  Code indentation
With Embedded Coder, you can specify how the software generates function interfaces

and packages the generated files. For more information, see the next example,
“Customize Function Interface and File Packaging” on page 3-27.
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Customize Function Interface and File Packaging

In this section...

“Model Interface” on page 3-27
“Subsystem Interface” on page 3-30
“Customize File Packaging” on page 3-31

With Embedded Coder, you can specify the function interfaces for models and atomic
subsystems in the generated code. You can also specify how the code is placed into files
and folders. This example uses the configured model roll from the example, “Generate
and Analyze C Code” on page 3-11. For this example, open rtwdemo_roll_codegen and
save it to a local folder as rol I .slx.

Model Interface

You can configure the interface of the code for the model in the Configuration Parameters
dialog box, on the Code Generation > Interface pane. By default, the model’s entry
points are implemented as void/void functions. Model roll is set to generate nonreusable
code with a minimal function interface.

When configuring the model interface, you can choose whether to produce reusable
or nonreusable code. Reusable code consists of reentrant functions that can be called
with different data sets. In general, nonreusable code executes more efficiently in an
embedded system because nonreentrant functions can avoid pointer dereference.

For this example, roll is configured to generate a nonreusable function interface. Verify
that Code interface packaging is set to Nonreusable function.

Code interface

Code interface packaging: |Nonreusab|e function v|

| Suppress error status in real-time model data structure

| Configure Model Functions |

For rol 1, the interface settings direct the code generator to create two entry point
functions to initialize and step through algorithm code.
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3-28

Configuration Parameter Description
Suppress error status in real-time Remove the error status field in the real-
model data structure is selected time model data structure

All Parameters > Single output/update |Produce a single entry point function to
function is selected step the model

All Parameters > Terminate function |Eliminate the entry point function to
required is cleared terminate the model

All Parameters > Combine signal/state |Produce a single data structure for the

structures is selected model’s global data

The software generates this code based on the following assumptions:

* The solver setting indicates that the step function executes the code at 40 Hz.

* The initialize function is called once prior to executing the step function.
Configure Model Initialize and Step Functions

You can specify the names of the model initialize and step function, and the function
prototype of the model step function.

1 To open the Model Interface dialog box, on the Interface pane, click Configure
Model Functions.

2 In the Model Interface dialog box, specify Function specification as Model
specific C prototypes.

3 Click Get Default Configuration. The Model Interface dialog box expands to
display the Configure model initialize and step functions parameters.




Customize Function Interface and File Packaging

“i Model Interface: roll
Description

Choose an interface for the model. Mote: for a subsystem that you build
from the right-click context menu, use the RTW.configSubsystemBuild

function to configure an interface.

Set model interface

=3

Function specification: | Model specific C prototypes

-

This function specification supports single rate and multirate single-
tasking models. Press Get Default Configuration to populate the initial
argument configuration for the model initialize and step functions.

Get Default Configuration

Configure model initialize and step functions
Initialize function name: roll_initialize
Step function name: roll_custom

Step function arguments:

l (*invokes update diagram)

m

Order Port Name Port Type Category

1 Phi Inport
2 Psi Inport
s pr
4 TAS Inport
5 AP_Eng Inport
6 HDG_Mode  Inport
7 HDG_Ref  Inport
4| 1 ‘—r‘

s

-

] p

Step function preview

roll_custom ( arg_Phi, arg_Psi, arg_P, arg_TAS, arg_AP_Eng,
arg_HDG_Mode, arg_HDG_Ref, arg_Turn_Knob, * arg_Ail_Cmd )

Validation

(*invokes update diagram)

[ 0K ” Cancel H

Help

|| Apply
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4 Change Initialize function name to roll_init.
5 Change Step function name to roll_step.

6 Inthe Step function arguments table, verify that the order of the first two
arguments is Phi and then Psi. You can use the Up and Down buttons to reorder
the arguments.

7 Modify the third return argument, P, to a Pointer in the Category column.
8 Change the Outport, Ail_Cmd, to return by Value in the Category column.

9 Click Validate, so that consistency checking is performed on the interface
specification.

Step function preview
arg_Ail_Cmd = roll_step ( arg_Phi, arg_Psi, * arg_PF, arg_TAS, arg_AP_Eng, arg_HDG_Mode,
arg_HDG_Ref, arg_Turn_Knob }

Validation
Validate | (*invokes update diagram)

0 Last validation succeeded.

10 Click Apply and OK.

11 In the Simulink Editor, press Ctrl+B to generate the code. In the code generation
report, see that the code matches the specification.

Subsystem Interface

You can configure how the software implements atomic subsystems in the generated
code. In the Simulink editor, locate the subsystem, BasicRol IMode.

Right-click BasicRol IMode and select Block Parameters (Subsystem).

2 In the Block Parameters dialog box, click the Code Generation tab. The Function
packaging parameter Auto option instructs the software to use its heuristic to
implement the system efficiently, based on its usage in the model. Otherwise, you
can specify the function implementation based on criteria that you are using for
execution speed and memory utilization.
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"L Function Block Parameters: BasicRollMode @
Subsystem

Select the settings for the subsystem block. To enable parameters on the
Code Generation tab, on the Main tab, select Treat as atomic unit'.

Main Code Generation |

Function packaging: llnllne *]
Auto
Inline

MNonreusable function k‘
Reusable function

3 Specify the Function packaging parameter as Nonreusable function.

4  To use the block name as the function name, in the dialog box, specify Function
name options as Use subsystem name.

5 To place the code for the function in a separate file and use the function name,
specify File name options as Use function name.

6 To pass the subsystem inputs and outputs as arguments to the function, specify
Function interface as Allow arguments.

7 Click Apply and OK.

8 Press Ctrl+B to generate the code. Verify that the subsystem code is in
roll_BasicRol IMode.c and its declaration is in roll_BasicRol IMode._h.

Customize File Packaging

In the previous section, using the Subsystem block parameters, you specified file
packaging of the generated code at the subsystem level. You can also configure file
packaging at the model level.

In the Configuration Parameters dialog box, on the Code Generation > Code
Placement pane, you can specify the File packaging format parameter with the
following options: Modular, Compact (with separate data file), and Compact.
This parameter instructs the code generator to modularize the code into many files or
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compact the generated code into a few files. If your model contains referenced models,
you can specify a different file packaging format for each referenced model.

For your model roll, the File packaging format is set to Modular. Therefore, the code
generator creates the following files:

roll.c

roll.h

roll_private.h

roll_types.h

Subsystem files: roll_BasicRolIMode.c and roll_BasicRol IMode.c

This example showed how to configure the function interfaces for a model and a
subsystem. The example showed how to configure your model to modularize the
generated code into different file packaging formats. The next example shows how to set
up your model to specify how data appears in the generated code. For more information,
see “Define Data in the Generated Code” on page 3-33.
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Define Data in the Generated Code

In this section...

“Control Placement of Data in Generated Files” on page 3-33
“Signal Representation in the Generated Code” on page 3-34
“Parameter Representation in the Generated Code” on page 3-38

“Save Data Objects in Data Dictionary” on page 3-39

To control how model data is represented in the generated code, you can specify Simulink
data objects. With data objects, you can create variables in the base workspace that allow
you to parameterize the specification of model data, such as signals and parameters. You
can use the variables to specify parameter and signal attributes. These variables also
determine how each parameter and signal is defined and declared in the generated code.

This example uses the configured model rol I from the example, “Generate and Analyze
C Code” on page 3-11. For this example, open rtwdemo_rol l_codegen and save it to a
local folder as roll _slIx.

Control Placement of Data in Generated Files

At the model level, you can control which generated files contain model data definitions
and declarations. Separating the data declaration and assignment simplifies the
integration of the code into the production environment.

For model roll, open the Configuration Parameters dialog box.

2 In the Configuration Parameters dialog box, open Code Generation > Code
Placement.

3 Set Data definition to Data defined in a single separate source file.
Set Data declaration to Data declared in a single separate header
file.
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Global data placement (custom storage classes only)

Data definition: lData defined in a single separate source file

Data definition filename:  global.c

Data declaration: lData declared in a single separate header file

Data declaration filename: global.h

#include file delimiter: [Auto

[7] use owner from data abject for data definition placement

4 Click Apply and OK.

By default, the code generator places definitions and declarations for global data that use
custom storage classes in the generated files global .c and global . h. Data that do not
use custom storage classes do not appear in these files.

You can also use custom storage classes such as ExportToFi le to override this default
placement.

Signal Representation in the Generated Code
Specify Storage Class for Signal Data

A storage class specification of a signal, parameter, or data object provides you with
control over how that entity is declared, stored, and represented in the generated code.
As you are preparing to generate code, consider how many data entities in your model
that you want to specify as a data object. If there are a large number, you can use the
Data Object Wizard to find candidates in your model and create data objects. These steps
show this workflow using two signals in the model roll.

In the Simulink Editor, select Code > Data Objects > Data Object Wizard.

In the Data Object Wizard, in the Find options group, select all of the check boxes.
Click Find.

Click the check boxes next to ai ICmd and phiCmd.

In the Class column, if the data object class is not Simulink_Signal, click Change
Class. In the dialog box, for the drop-down list Signal, select Simulink.Signal.
Click OK.

A b WON -
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In the Data Object Wizard, click Create to create the data objects. When the data
objects are created in the base workspace, the signal names no longer appear in the
Data Object Wizard.

Close the Data Object Wizard.
In the Simulink Editor, open the Model Explorer by clicking the icon.

In the Model Explorer, on the left pane, in the Model hierarchy tree, click Base

Workspace. The newly created data objects are now listed in the base workspace
(center pane).

The next step is to associate the data objects with the signals.

Configure Signal Data Objects

To configure the new signal data objects ai ICmd and phiCmd, define the data objects
such that the code generator places them in a struct in the generated code.

1

In the Model Explorer, with the base workspace available in the center pane, select
ailCmd.

The Simulink.Signal properties are displayed in the right pane.
Specify the Storage class as Struct (Custom).
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o

Dimensions: -1
Initial value:
Minimurm: L[]
Units:

Code generatio

Storage class:

Description:

i Ignal: antm
"] Simulink.Signal: ailCmd

Data type: single -

Dimensions mode: [autcr *]
Complexity: [auto - ]
Maximum: []
Sample time: -1

n options

Auto =

Auto

SimulinkGlobal

ExportedGlobal

ImportedExtern

ImportedExternPointer
Default {Custom)

BitField (Custom)
Volatile (Custom)
ExportToFile (Custom)
ImportFromFile (Custom)

FiIeSane ECustnmi

GetSet (Custom)
Reusable (Custom)

[ oK ] [ Cancel ] [ HE.‘|p prh?

Specify StructName as signal_data.

Click Apply.

Repeat steps 1 through 4 for phiCmd. ai ICmd and phiCmd use the same
StructName, signal_data.
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7

On the Code Generation > Interface pane, click the Configure Model
Functions button. On the Model Interface dialog box, set the Function
specification parameter to Default model initialize and step
functions. Click Apply and OK.

In the model, press Ctrl+B to generate code.

Now the variables ai ICmd and phiCmd are defined in a struct in roll.h and used in
roll.c. The struct definition looks similar to the following:

/* Type definition for custom storage class: Struct */

typedef struct signal_data _tag {
real32_T phiCmd;

real32_T ailCmd;

} signal_data_type;

Resolve Signal with Data Object

You must specify that a signal name is associated with a data object in the base
workspace. For each signal, ai ICmd and phiCmd, do the following:

4

In the Simulink Editor, right-click the signal line.
From the list, select Properties.

In the Signal Properties dialog box, observe that the Signal name must resolve
to Simulink signal object parameter is selected. When the Data Object Wizard
created Simulink.Signal data objects, the software set this parameter.

Click OK.

Notice the signal object icon on the signal. This icon is another indication that the signal
1s associated with a Simulink.Signal object in the base workspace.
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Roll Axis Autopilot Model
Copyright 1880-2014 The MathWorks, Inc.

DoC
Teaxd|
System 110
_"'_\[ [-180..180] Specification
—H e Disp_Cond
—| . F | -EphiCmd
MeodeSwitch
o Disp_FB
[-15.15]
20,501 Surf_Cmd T
[50..60] [-15..15]
{2} 4 Rate_FB %I : N
P =F @il med o
0 | e L F Ail_Cmd
P Engaged
Zero EngSwitch

BasicRollMode

Parameter Representation in the Generated Code

An alternative workflow to using the Data Object Wizard is to add objects to the base
workspace in the Model Explorer. You can add objects for both signals and parameters.
This example shows how to create Simul ink.Parameter objects for constant values in
the model roll.

1 In the Simulink Editor, double-click the subsystem Rol lAngleReference. Locate
the Constant blocks UpThr and LoThr.

2 For each Constant block:

a Right-click the block and select Block Parameters (Constant) from the list.

b In the Block Parameter dialog box, replace the numeric Constant value with
the corresponding variable name: upThr for 6, or loThr for -6.

¢ Click Apply and OK.
3 In the Model Explorer, in the left navigation pane, select Base Workspace.
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4 From the menu bar, select Add > Simulink.Parameter. This action creates a
Simulink.Parameter object with the default name Param in the center pane.

5 In the center pane, click the name of the object and rename it to upThr. Press
Enter. The data object properties for upThr are displayed in the right pane.

6 In the right pane, specify the properties as follows:

* Valueis 6
+ Storage class is ExportTofile (Custom)
+ HeaderFile is specified as threshold
7 Click Apply.
8 Repeat steps 4 through 7 for loThr, using -6 as the Value.

In the Model Explorer, this graphic is how the base workspace appears.

E Contents of: Base Workspace (only) Filter Contents

Column View: |Data Objects - I Show Details 4 object(s) fr"v
Mame Value DataType Min Max Dimensions StorageClass Comple

[ &ilCmd single [1 11 1 Struct (Custom) auto

[ phiCmd single [1 11 1 Struct (Custom) auto

L] UpThF & auto [1 11 ExportToFile {Custom)

[e1e] laThr ] auto [1 11 ExportToFile (Custom)

9 From the Simulink Editor, press Ctrl+B to generate code.

10 In the code generation report, select threshold.h. In the file, find the data
declarations for upThr and loThr.

11 In the file global.c, find the data definitions. Because the data objects upThr
and loThr use a custom storage class, by default the generated code places the
definitions in global . c.

Save Data Objects in Data Dictionary
Data objects that you create in the base workspace are not saved with the model. When

you end your MATLAB session, these objects do not persist. To permanently store these
objects, you can save them in a data dictionary and link the model to the dictionary.
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1 In the model, select File > Model Properties > Link to Data Dictionary.

2 In the Model Properties dialog box, select Data Dictionary. Click New.

3 In the Create a new Data Dictionary dialog box, set File name to rol IDict. Click
Save.
The data dictionary file rol IDict.sldd appears in your current folder.

4 In the Model Properties dialog box, click OK.

Click Yes in response to the message about migrating base workspace data.

(8]

6 Click Yes in response to the message about removing imported items from the base
workspace.

7 In the lower-left corner of the model, click the data dictionary badge.
The contents of the data dictionary appear in the Model Explorer.

The data dictionary rolIDict.sldd permanently stores the Simulink.Signal and
Simulink.Parameter objects that the model uses.

This example shows how to define data objects to represent signal and parameter data
in the generated code. The next example shows how to deploy and verify an executable
program for your model. For more information, see “Deploy and Verify Executable
Program” on page 3-41.

Related Examples
. “Control Data Representation by Applying Custom Storage Classes”

More About

. “Data Objects”

. “What Is a Data Dictionary?”

. “Default Data Structures in the Generated Code”
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Deploy and Verify Executable Program

In this section...

“Test Harness Model” on page 3-41
“Simulate in Normal Mode” on page 3-42
“Simulate in SIL Mode” on page 3-44
“Compare Simulation Results” on page 3-44

“Improve Code Performance” on page 3-45

“More Information About Code Generation in Model-Based Design” on page 3-46

To verify code execution results, you can use software-in-the-loop (SIL) and processor-
in-the-loop (PIL) testing. A SIL simulation involves compiling and running production
source code on your host computer. A PIL simulation involves cross-compiling and
running production object code on a target processor or an equivalent instruction set
simulator. Embedded Coder automates execution of generated code in Simulink for SIL
testing or on the embedded target for PIL testing using Simulink simulation modes or S-
function blocks. You can use SIL and PIL simulations to:

+ Verify the numerical behavior of your code.
+  Collect code metrics such as code coverage and execution profiling data.
*  Optimize your code.

*  Progress towards achieving IEC 61508, IEC 62304, ISO 26262, EN 50128 or DO-178
certification.

This example simulates a test harness model in normal mode, and then simulates the
model in SIL mode. Results are logged to the Simulation Data Inspector. Comparing
the results helps you verify that simulating the model produces the same results as
executing the generated code.

Test Harness Model

One method for verifying the code generated for a model is to use a test harness
model that includes the model to be tested as a referenced model. You can generate a
test harness model with Simulink Verification and Validation software. With a test
harness model, you can easily switch the Model block between normal, SIL, or PIL
simulation mode. Test vectors provide a baseline for the behavior of the generated
code and verify that the model meets requirements. This example uses a test harness
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model, rtwdemo_rol I_harness, which generates test inputs to the referenced model,
rtwdemo_roll_codegen.

3-42

Maneuver 1 ? rtewdemo_roll_codegen
. !y . .
Phi ? EyTE— P In Ot | Fhi
Psi . B InZ Out2 ] Psi
? Heading
P P In3 Out3 » P
T Foll Rate
TAS »
/\ T p{ind  Outd » TAS ait emal T N
AF_Eng - p{InE  Outs » AP _Eng - ailCmd  —
? Autopibt Engaged Ail Cmd
HDG Mode - | Indi Ourt p HDG_Mode
? Heading Hold
HDG_Ref . — P InT OutT | HD_Ref
T Hezding Ref&rence l:l
Turn_Knob Y — | 02 Ourtd ] Turn_Knob >
and
Test Inputs Signal Comversion Reall Aucis Autopilot Scope

Test Harness For
Roell Axis Autopilot Model

Copyright 1990-2014 The MathWorks, Inc.

When running in SIL simulation mode, the configuration parameters for the top model
and the referenced model must match.

1  Open the example models rtwdemo_roll_harness and rtwdemo_roll_codegen.
2 Save rtwdemo_roll_harness as roll_harness to a local folder.

3 Open the Configuration Parameters dialog boxes for roll _harness and
rtwdemo_roll_codegen.

4 For roll_harness, on the Code Generation pane, verify that the Generate code
only check box is cleared.

5 Onthe Hardware Implementation pane, expand Device details. If Support
long long is not already selected, select the check box.

6 If you make changes, click Apply and OK.

Simulate in Normal Mode

Run the harness model in normal mode and capture the results in the Simulation Data
Inspector.

1 To send logged data from the workspace to the Simulation Data Inspector for
model roll_harness, on the Simulink Editor toolbar, click the Simulation Data
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Inspector button arrow and select Send Logged Workspace Data to Data
Inspector.

o]

2 Right-click the Model block, Roll Axis Autopilot, and from the context menu,
select Block Parameters (ModelReference).
3 In the Block Parameters dialog box, for Simulation mode, verify that the Normal
option is selected. Click OK.
4 Simulate roll_harness.
5 When the simulation is done, view the simulation results in the Simulation Data
Inspector. If the Simulation Data Inspector is not already open, in the Simulink
Editor, click the Simulation Data Inspector button.
6 For the new run, double-click the run name field and rename the run:
roll_harness: Normal mode.
7 Expand the run and select ai ICmd to plot the signal.
Runs
« roll_harness: Normal mode * \\\\
CET.

Autopilot Engaged
Heading

Heading Hold
Heading Reference
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Roll Command
Roll Rate

True Airspeed

Name

Line Appearance
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Nimensinns
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1
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Simulate in SIL Mode

In a SIL simulation, code is generated, compiled, and executed on the host computer.
Results are logged in the Simulation Data Inspector, in addition to the results from
running in normal mode.

1 Inthe roll_harness model window, right-click the Rol'l Axis Autopilot model
block and select Block Parameters (ModelReference).

2 In the Block Parameters dialog box, specify Simulation mode as Software-in-
the-loop (SIL). Click Apply and OK.

3  On the Simulink Editor toolbar, verify that logged data recording is on.

s

Simulate the roll _harness model.

5 In the Simulation Data Inspector, double-click the run name field and rename the
new run to roll_harness: SIL mode.

6 Expand the run and select ai ICmd to plot the signal.

Compare Simulation Results

In the Simulation Data Inspector:

Click the Compare tab.

2 For Baseline, select roll_harness: Normal mode. For Compare To, select
roll_harness: SIL mode.

3 Click Compare.
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VISUALIZE COMPARE FORMAT
P 20
@ Baseline: roll_harness: Normal mo v 1 [z Create Report
Comparison ~ Compare To: | rol_harness: Sl mode Compare [l send to Figure
Options Runs
OFTIONS | COMPARE RUNS I SHARE
|
£ COLOR (BASE) |COLOR (COMP)|ABSTOL [RELTOL |PLOT

« Compare roll_harness: SIL mode to roll_harness: Normal mode

“Toens 1l oo (0]
=

@ Autopilol Engaged e 0 0.00% O
@ Heading — 0 0.00%
@ Heading Hold — — 0 0.00%
@ Heading Reference s — ] 0.00%
@ Roll Attitude — 0 0.00%
@ Rol Command — 0 0.00%
@ Roll Rate — — 0 0.00%
@ True Airspeed — — 0 0.00%
Mame ailCmd (roll_harnes... ailCmd (roll_hames..

Line Appearance —_— —_—

Color —

Absolute Tolerance o o

Relative Tolerance 0.00% 0.00%

Units

Run Compare roll_harn... Compare roll_harn...
Align By Path Path

Model roll_harness roll_harness

fa

»

Signals

10

12

Difference and Tolerance

14

18 18 20 2z 24 2 28 30
18 15 20 22 24 26 28 30

If you find differences in testing results, it is important to investigate and understand the
differences. Some differences can be attributed to implementation changes (converting
from an interpreted model to an executable implementation), or can be an indication of
bugs. You must understand all differences to confirm that the behavior of the system is

free of bugs.

Improve Code Performance

To generate code that meets code performance requirements, you can design and
configure your model to support code generator optimizations. You can use the Code
Generation Advisor for guidance on configuring your model to meet code generation

objectives.
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After testing your model and code, you can fine-tune your model configuration to improve
the code performance. For a specific performance goal, Embedded Coder provides model
configuration parameters on the Optimization panes to help you improve memory

usage and reduce execution time.

When choosing optimization parameters for your model, consider the trade-offs of
one optimization over another optimization. Improving one area of performance can
sacrifice another area of performance. For example, reducing memory usage can sacrifice

execution efficiency.

More Information About Code Generation in Model-Based Design

The following table includes links to additional information for generating, executing,
and verifying production code for your model.

To

See

Quickly generate readable, efficient code
from your model

“Generate Code with the Embedded Coder
Quick Start Tool”

Consider model design and configuration
for code generation

“Model Architecture and Design”

Generate code variants using macros for
preprocessor compilation from models

“Variant Systems”

Achieve code reuse

“Subsystems” and “Referenced Models”

Define and control model data

“Data Representation”

Control generation of function and class
interfaces

“Function and Class Interfaces”

Control naming and partitioning of data
and code across generated source files

“File Packaging”

Select and configure the target
environment for your application

“Target Environment Configuration”

Configure model for code generation
objectives, such as efficiency or safety

“Configure Model for Code Generation
Objectives Using Code Generation Advisor”

Configure parameters for specifying

identifier names, code comments, style, and

templates

“Code Appearance”
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To

See

Export component XML description and C
code for AUTOSAR run-time environment

“AUTOSAR Code Generation”

Deployment of standalone programs to
target hardware

“Deploy Generated Standalone Executables
To Target Hardware”

Choose and apply integration paths and
methods

“External Code Integration”

Improve code performance, such as memory
usage and execution speed

“Performance”

Collect code coverage metrics for generated
code during SIL or PIL simulation,

using a third-party tool to measure test
completeness

“Code Coverage”

SIL and PIL testing

“Software-in-the-Loop (SIL) Simulation”
and “Processor-in-the-Loop (PIL)
Simulation”

View and analyze execution profiles of code
sections

“Code Execution Profiling”
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Embedded Coder Documentation
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The Embedded Coder documentation is divided into two categories:

Code Generation from MATLAB Code

Provides information on generating C and C++ code from MATLAB code. This
documentation is targeted to customers who are not generating code from Simulink
models and do not have the Simulink and Simulink Coder products. To get started
generating C and C++ code from MATLAB code, see “Generate C Code from MATLAB
Code” on page 2-2.

Code Generation from Simulink Models

Provides information on generating C and C++ code from Simulink models. This
documentation is targeted for customers who are generating code from Simulink
models and have the Simulink and Simulink Coder products. Typically, these
customers generate C and C++ code from MATLAB code by using the MATLAB
Function block in a Simulink model. To get started generating C and C++ code from
Simulink models, see “Generate C Code from Simulink Models” on page 3-2.
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Installing Eclipse IDE and Cygwin Debugger

In this section...

“Installing the Eclipse IDE” on page A-2

“Installing the Cygwin Debugger” on page A-3

Installing the Eclipse IDE

This section describes how to install the Eclipse IDE for C/C++ Developers and the
Cygwin debugger for use with the integration and verification tutorials. Installing
and using the Eclipse IDE for C/C++ Developers and the Cygwin debugger is optional.
Alternatively, you can use another Integrated Development Environment (IDE) or use
equivalent tools such as command-line compilers and makefiles.

1

From the Eclipse Downloads web page (http://www.eclipse.org/downloads/), download
the Eclipse IDE for C/C++ Developers to your C: drive.

You also need the Eclipse C/C++ Development Tools (CDT) that are compatible with
the Eclipse IDE. You can install the CDT as part of the Eclipse C/C++ IDE packaged
zip file or you can install it into an existing version of the Eclipse IDE.

If You Install the CDT... Then...

As part of the Eclipse C/C++ IDE | Go to step 4
packaged zip file

Into an existing version of the Go to step 2
Eclipse IDE

From the Eclipse CDT Downloads page (http://www.eclipse.org/cdt/downloads.php),
download the Eclipse C/C++ Development Tools (CDT) that is compatible with your
installed version of the Eclipse IDE.

Unzip the downloaded Eclipse CDT zip file. Copy the contents of the directories
features and plugins to the corresponding directories in c:\eclipse.

Create the folder c:\eclipse.
Unzip the downloaded Eclipse IDE zip file into c:\eclipse.

On your desktop, create a link to the executable file c:\eclipse\eclipse.exe.
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Installing the Cygwin Debugger

1

From the Cygwin home page (http://www.cygwin.com), download the Cygwin
setup.exe file.

Run the setup.exe file. A Cygwin Setup - Choose Installation Type dialog box
opens.

Follow the installation procedure:

Select the option for installing over the Internet.
+ Accept the default root folder c:\cygwin.
Specify a local package folder. For example, specify c:\cygwin\packages.
+  Specify how you want to connect to the Internet.
Choose a download site.
In the dialog box for selecting packages, set the Devel category to Install by clicking
the selector icon #¥.
Add the folder c:\cygwin\bin to your system Path variable. For example, on a
Windows XP system:
a Click Start > Settings > Control Panel > System > Advanced >
Environment Variables.
b Under System variables, select the Path variable and click Edit.
Add c:\cygwin\bin to the variable value and click OK.

Note: To use Cygwin, your build folder must be on your C drive. The folder path cannot
include spaces.
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Integrating and Testing Code with Eclipse IDE

A4

In this section...

“About Eclipse” on page A-4

“Define a New C Project” on page A-4
“Configure the Debugger” on page A-5

“Start the Debugger” on page A-6

“Set the Cygwin Path” on page A-6

“Debugger Actions and Commands” on page A-7

About Eclipse

Eclipse Wwww.eclipse.org) is an integrated development environment for developing
and debugging embedded software. Cygwin (Www.Cygwin.com) is an environment that is
similar to the Linux environment, but runs on Windows and includes the GCC compiler
and debugger.

This section contains instructions for using the Eclipse IDE with Cygwin tools to build,
run, test, and debug projects that include generated code. There are many other software
packages and tools that can work with code generation software to perform similar tasks.

“Installing Eclipse IDE and Cygwin Debugger” on page A-2 contains instructions for
installing Eclipse and Cygwin. Before proceeding, be sure you have installed Eclipse and
Cygwin, as described in that section.

To use Cygwin, your build folder must be on your C drive. The folder path cannot include
spaces.

Define a New C Project

1 In Eclipse, choose File > New > C Project. A C Project dialog box opens.
2 Inthe C Project dialog box:
a Inthe Project name field, type the project name throttlecntrl_## (## is
externenv or testcode) .

b In the Location field, specify the location of your build folder (for example, C:
\EclipseProjects\throttlecntrl\externenv).



http://www.eclipse.org/
http://www.cygwin.com/
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In the Project type selection box, select and expand Makefile project.
Click the Empty Project node.
Under Other Toolchains, select Cygwin GCC .

® o o

f  Click Next. A Select Configurations dialog box opens.

In the Select Configurations dialog box, click Advanced settings. The Properties
dialog box appears.

In the Properties dialog box:

a Select C/C++ Build.
b Select Generate Makefiles automatically.
Select the Behavior tab.

o o0

Select Build on resource save (Auto build).
e Click Apply and OK.

The Properties box closes.

In the Select Configurations dialog box, click Finish.

Configure the Debugger

1

In Eclipse, choose Run > Debug Configurations. The Debug Configurations dialog
box opens.

Double-click C/C++ Application. A throttlecntrl_externenv Default entry
appears under C/C++ Application. The Main tab of the configuration pane appears
on the right side of the dialog box with the following parameter settings:

Parameter Setting

Name throttlecntrl_externenv Default
C/C++ Application Default\throttlecntrl_externenv.exe
Project throttlecntrl_externenv

Build configuration Default

Enable auto build Cleared

Disable auto build Cleared

Use workspace settings Selected
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3

Click Close.

Start the Debugger

To start the debugger:

1

In the main Eclipse window, select Run > Debug. A Confirm Perspective Switch
dialog box opens.

Click Yes. Tabbed debugger panes that display debugging information and controls
are displayed in the main Eclipse window.

Specify the location of the project files. The Cygwin debugger creates a virtual

drive (for example, main() at /cygdrive/) during the build process. To run the
debugger, Eclipse remaps the drive or locates your project files. Once Eclipse locates
the first file, it automatically finds the remaining files. In the Eclipse window, click
Locate File. The Open dialog box opens.

For information on using the Edit Source Lookup Path button, see “Set the
Cygwin Path” on page A-6.

Navigate to the example_main.c file and click Open. Your program opens in the
debugger software.

Set the Cygwin Path

The first time you run Eclipse, you get an error related to the Cygwin path.

To provide the path information:

1

o 0 A WOWDN

N

Open the Debug Configurations dialog box by selecting Run > Debug
Configurations > C/C++ Application.

Click the Source tab.

Click Add. The Add Source dialog box opens.

Select Path Mapping and click OK. The Path Mappings dialog box opens.
Click Add. In the Compilation path field, type \cygdrive\c\.

In the Local file system path field, click the Browse button, navigate to your C:\
drive, and click OK.

Click Apply.
Click Close.
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Debugger Actions and Commands

The following actions and commands are available in the debugger.

Action Command

Step into F5

Step over Fé6

Step out F7

Resume F8

Toggle break point Ctrl + Shift + B







